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Computer-1

Chapter-1

A 1.X2.X3.V4/5X6.Y

B. 1(a) 2.(a)

C. 1.man-made 2. machine 3.computer 4.electricity

D. 1.T 2.F 3.T 4.F

E. 1. Computer is a machine which needs electricity and user's instructions to

work.

2. (a) Television (b) Car (c) Watch (d) Refrigerator (¢) Computer

3. (a) Computer can prepare exam results. (b) Computer can be used to prepare
bills on a shop.

Chapter-2

A. 1.mouse?2.speakers 3. keyboard 4. CPU 5. monitor 6. printer

B. 1.(b)2.(c)3.(a)4.(a)

C. 1.parts2. monitor 3. mouse 4. brain

D. 1.F2.T3.T4.F5.T

E. 1. mouse, monitor, keyboard 2. CPU solves all the problems according to

instructions 3. (a) Mouse is used to give instructions to the computer. (b) It is
used to select the objects. (¢) It is used to draw pictures and play games. 4. The
printer is used for printing information on paper.

hapter-3

1. Enter 2. Delete 3. Alphabet keys 4. Number keys

1.(b)2.(b)3.(b)

1. Alphabet 2. 0-9 3. Space bar 4. Enter key

1.2 2.1 3.9 4.26

1. I will use the Alphabet keys to write my name. 2. Keys from 0-9 are called
number keys. 3. It is used to give a blank space between letters or words. 4. It is
used to erase anything typed in the right of cursor.

Chapter-4

C. 1.(b)2.(c)3.(b)

D. 1.two buttons 2. scroll wheel 3. pointer 4. click

E. 1.F 2.T 3.F 4.T

F. 1. A mouse has two or three buttons. 2. Pressing and releasing mouse button
creates a click sound. 3. Pressing and releasing the mouse button twice quickly.

Chapter-5

B. 1.(b) 2.(a)

C. 1.T 2.F 3.F 4.T

D. 1.Start 2. Shutdown 3. Monitor 4.UPS

E. 1.(a) Switch onthe main power switch. (b) Then, switch on the UPS. (¢) Switch

on the power button of monitor. (d) Finally, switch on the CPU.
2. 'Restart' button is used to start the computer again.

Chapter-6

A.
B.
C.

L.(X)2.(vV)3.(V)4.(X)5.(X)
1.(c)2.(b)3.(a)
1.F2.T3.F4.T



D. 1.Dustcovers save the computer from the dust.
2. (a) Form a queue to enter the computer room. (b) Make your shoes dust free.
(c) Do not eat or drink on the computer table.

Chapter-7

A 2

B. 1.(c)2.(a)3.(a)4.(c)

C. l.education?2. banks 3. disease 4. railway 5. station

D. 1.F2.F3.F4.T5.T

E. 1.(b)2.(d)3.(a)4.(c)

F. 1. Computer are used in schools- (a) to educate the children. (b) to keep the
record of students.
2. Computers are used in hospitals- (a) to keep the information of patients. (b)
to diagnose the diseases.

Computer-2

Chapter-1

A. 1.Palmtop 2. Laptop 3. Tablet

B. 1.Icanrun-A computer cannot.
2.Ican drink milk - A computer cannot.
3.Icanread my book - A computer cannot.

C. 1.(b)2.(a)3.(c)4.(b)

D. 1.electronic 2. mistakes 3. capacity 4. intelligence 5. desktop

E. 1.T2.T3.T4.F5.F

F. 1. (a) A computer works at a very high speed. (b) A computer has a very large
storage capacity. (¢) A computer does not feel tiredness.
2. A computer can not take decisions independently. It needs a human to
operate.
3. There are following different types of computer- desktop, laptop, palmtop
and tablet.

Chapter-2

A. Milkisboiled and coffee and sugar is mixed with it; cake; sharpening

B. 1.(b)2.(a)3.((b)

C. .LF2.T3.T4F

D. 1.Entering any data and instructions into the computer is called input.
2. Work done by the CPU on data using specified instructions is called the
processing.

Chapter-3

A. 1.12.03.14.15.06.0

B. 1.(c)2.(a)3.(c)

C. 1.hand-held2.joystick 3. processing 4. paper 5. voice

D. 1. Input Devices : The parts of a computer which help us to give input to the

computer in the form of data and instructions are called Input devices. The
three input devices are : Keyboard, mouse and joystick.

2. Output devices : The parts of a computer which help us to show the results
of processing are called output devices. The examples are : monitor, printer and
speakers.
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3. Processing Device : All the data inputs are stored, arranged and changed into
meaningful information by the computer. It is done by a processing device. The
processing device in a computer is known as the Central Processing Unit or the
CPU. Itis located inside the CPU Tower.

Chapter-4

A.

1. Selects 2. Opens 3. Displays B. 1. (¢) 2. (a) 3. (b) C.Do yourself
D. I.two, three 2. mouse pointer 3. middle 4. index E.1.F2.F3.T4.T

E. 1.Acomputer mouse has two or three buttons. Left mouse button is used for left
click and right mouse button is for right click.
2.Keys marked with the numbers are known as numeric keys.
3. Double click is used to open an object.
4. Follow these steps for dragging an object :
Step-1 : Place the mouse pointer on the item which you want to move.
Step-2 : Click it to select.
Step-3 : Press and hold the left button of the mouse.
Step-4 : Pull the item to the desired location (dragging).
Step-5 : Release the button.

Chapter-5

A. 1. desktop 2. icon 3. start 4. window B. 1.(c)2.(a)3.(b)

C. 1. desktop 2. icons 3. clock 4. Start

D. 1. Once the computer is switched on, you get the first display screen known
as the desktop. It has many small icons on the left and a bar at the bottom of
the screen.
2. A single click of mouse selects an icon and double-click opens it.
3. Taskbar is placed at the bottom of screen on desktop. It shows the tasks
that the computer is currently doing. The START button is on the left side of
the taskbar.
4. You can change the size of a window as per your need. If your window is
in the normal size, bring the mouse pointer at any of the corners of that
window. Now, hold down the left button of the mouse and drag it to reduce
or enlarge the size of your window.

E. 1. My Documents

2. Recycle Bin \‘jj
3. Network

X
4. Computer & ‘

5. Internet Explorer



Chapter-6

mUOwe

1. Color-box 2. Line tool 3. Rectangle tool 4. Ellipse tool 5. Eraser tool
1. (b)2.(c) 3. (a)

1. Paint 2. Toolbar 3. Line 4. Eraser

1.F2.F3.T4.T

1. Step-1 : Click on the Start button.

Step-2 : Click on All Programs option.

Step-3 : Click on Accessories.

Step-4 : Now, click on the Paint with the mouse.

2. A rectangle tool is used to draw a square in PAINT program.

Step-1 : Click on rectangle tool.

Step-2 : Click on the size tool.

Step-3 : Select the width of line thickness.

Step-4 : Take the pointer to the drawing area.

Step-5 : Press and hold down the left mouse button along with shift key to
draw the square.

Chapter-7

mUO0we

2,6,7and 8

1.(c)2.(a)3.(c) 4. (b)

1. family, library, shopkeepers, passengers

1.d;2.b;3.a;4.¢

1. (a) Computer at homes : - Computers help us to do home work.

- Computers help us to calculate the monthly expenses of family.

(b) Computers at Shops : - Computers are used to maintain records of the
stock.

- The computers help the shopkeepers to prepare bills.

(c) Computers at Offices : - Computers are used in offices to maintain the
records of employees.

- Computers are used to type, edit and print documents and letters.

Computer-3

Chapter-1

A.

monw

1. On the keyboard, keys in the first row are arranged in the order QWERTY.
So, keyboard is called the QWERTY keyboard.

2. The memory unitin CPU stores the data, instructions are temporary results.
3. ACD-ROM is a device that stores information outside the computer. It is an
external storage device.

1.(b)2.(c)

1. keyboard 2. microchip 3. result4. paper 5. functions, computer
1.F2.T3.F4.F5.T

1. The main function of a computer system is processing the instructions given
by user and produce the desired output.
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2. Inputdevices : keyboard, mouse

Output devices : monitor, printer

3. Pressing and holding primary mouse button (i.e. left button) while moving
the mouse is called dragging. This term is associated to mouse.

4. ADVD is adata storage medium. This external storage device can store more
data thana CD-ROM.

Chapter-2

A.

oaw

1. Application software 2. System software 3. Application software 4. System
software 5. System software

1.(c)2.(b)3.(a)

1. wires 2. software 3. application 4. MS-Paint 5. computer

1. The parts of a computer that we can touch and see are called hardware. So,
the hardware is tangible. All the input, output and processing devices such as
monitor, keyboard, mouse, CPU, printer, etc. are called hardware of a
computer.

2.a. Hardware : monitor, keyboard

b. Software : application software, system software

3. The computer hardware cannot work alone. The software is an interface
between the computer hardware and user.

Fun Time

A.
B.

1. Notepad 2. Windows Media Player 3. Calculator 4. Paint Brush
1. Command 2. Linux 3. Microsoft 4. Windows 5. Paint 6. Word 7. Power Point

Chapter-3

A.

oaw

1. Don't bring food or drink near the keyboard. If these spill on to your
keyboard, it might be harmed.

2. It is not safe. First install a good anti-virus program. This will protect your
computer from harmful programs called viruses.

3. Always make sure that your hands are clean before you start working on it. It
will save your computer from dust and dirt.

4. Always use original software as the pirated software gets corrupt and harms
your computer hardware.

5. Always call an expert if your computer is giving trouble.

1.(c)2.(a)

1. dust 2. pirated 3. viruses 4. shiny 5. CD pen

1. Dust your computer with a clean, dry and soft cloth regularly. Keep it
covered when you are not using it.

2. Install a good anti-virus program. It will protect your computer from harmful
programs called viruses.

3. (a) Use amouse pad to move your mouse.

(b) Don't touch the mouse with dirty or sticky fingers.

(¢) Clean the mouse with a soft, dry cloth.

4. The computer reads the data on these disks from shiny side.

Chapter-4

A.
B.

1. Start button 2. Date and Time 3. Desktop
1.Icons 2. Start button 3. Taskbaricons 4. Date and Time

<o



1.(c)2.(b)3.(a)4.(c)

1.F2.F3.T4.TS.F

1.(c)2.(e)3.(a)4.(b)5.(d)

1. Windows is the most popular operating system software across the world. It
is developed by the Microsoft Corporation Inc., USA.

2. Features of Windows

(a)Easytouse.

(b) Convenient to perform various tasks.

(c) Easy to install and run various application systems.

(d) Easy tounderstand and use GUI.

3. (a) Desktop : The first screen that appears on the monitor is called the
desktop. Various items available on the desktop help us to work with programs
and documents.

(b) Start Button : The round button on the left corner of the taskbar is Start
button. When we click on Start button, a list of menus and sub-menus appears
which are used to run various applications, programs and documents.

4. Follow these steps to open an application/program using the start button.
Step-1 : Click on the Start button.

Step-2 : Now, click on All Programs option.

Step-3 : Click on Accessories.

Step-4 : Click on the Notepad option.

Chapter-5
Brain Storming

A. Quick Access
rToolbar Tabs

Paint =
Button ... .

L

Drav&}ing Area
B. 1.(b)2.(a)3.(c)
C. 1. paint 2. view 3. home, colours 4. mirror 5. select

D. 1. {d Curve
2. D Select

3. 1O Brush

™o 0

— =

.I=I II:II;-

Line

Circle

E. 1. Quick Access Toolbar is situated on the left side of the title bar. It
contains the buttons like Save, Undo, Redo, etc.

2. We use this command to change the size of drawing by making it bigger
or smaller.
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Step - 1 : First, click on Home tab.

Step - 2 : Click on Select. Now, select the image by dragging the mouse
over it.

Step - 3 : Click on Resize. It will open the Resize and Skew Dialog box.
Step - 4 : Select the Maintain aspect ratio click box.
Step - 5 : Now, select the pixels ratio button.

Step - 6 : Type the horizontal value (width) or vertical value (height), the
other will automatically adjust itself.

Step - 7 : Click on OK.
It will change the size of image as desired.

3. Cut and Paste : When we cut a selected area it disappears from its
original location. When we click Paste, it gets pasted on the clicked area.

Copy and Paste : Copy and paste means the selected portion will not be

lost from the original image and you will get another copy of the selected

position at the new location.

4. (a) Select an image :

Step - 1 : Click on Home tab.

Step - 2 : Click on Select. A menu will appear.

Step - 3 : Now from this menu, select the rectangular selection tool.

Step -4 : Move the pointer near the portion of the drawing you wish to
select.

Drag the mouse pointer while holding the left mouse button. As you do so, a

box with dashed lines will appear. Drag the pointer in such a way that only

the area you want to select remains inside the box.

Step - 5 : After doing so, release the left mouse button. The desired region
will be selected.

(b) In Paint, you can also add your own text or message in your picture :

Step - 1 : In the Tools group, click on the Home Tab and then click the Text
tool.

Asyou click the Text tool, the Text Tab appears along with other tabs.

Step-2 : Dragthe pointer in the drawing area where you want to add text.

Step-3 : Choose the font face, size, and style in the Text tools. This can be
found in the Font group under the Text tab.

Step-4 : Typethe text using the keyboard.

Step-5 : Click the cursor anywhere outside the text box to exit the Text tool.

(c) Follow these steps to Flip/Rotate the image :

Step - 1 : First, click on Home tab.

Step - 2 : Click on Select.

Step - 3 : Drag the mouse pointer to select the object.

Step - 4 : Click on rotate. It will open the Rotate and Flip menu.

Step - 5 : Click on rotation direction you want. For example, right 90°.



Chapter-6

A.
B.
C.

1. (b) 2. (b) 3. (a)

1. notepad 2. untitled 3. calculator 4. numeric, keyboard

1. Notepad is a popular program that is used to type simple words,
sentences, paragraphs or notes without much formatting.

2. An insertion point or cursor is the flashing line that allows the text to be
typed from its position.

3. The calculator is a very simple and useful program of Windows. It is used
to perform simple mathematical calculations.

1. Follow these steps to open Notepad.

Step-1 : Click on the Start button.

Step-2 : Click on All Programs.

Step-3 : Click on the Accessories.

Step-4 : Now, click on the Notepad to open it.

2. Steps to start the calculator program :

Step-1 : Click on the Start button.

Step-2 : Click on All Programs.

Step-3 : Click on Accessories.

Step-4 : Click on Calculator program to open it.

Chapter-7

A.
B.

C
D.

1.(b)2.(c)3.(a)4. (a)
1. Quick Access Toolbar 2. Ribbon, tabs, groups 3. Enter key 4. review, edit
1.F2.T3.F4.T5.T

1. WordPad : Just like Notepad and Calculator, WordPad is also a utility
available in Windows Accessories.

2. Text Area : It is the blank white space which covers most of the window
area. It is used to type text using keyboard.

1. Step - 1 : First click on WordPad button.

Step-2 : Click the Open option. The Open dialog box appear.
Step-3 : Click on the name of the file that you want to open.
Step-4 : Now, click on Open button.

2. Follow these steps to save your document in WordPad.
Step-1 : Click on WordPad button. A menu appears.

Step-2 : Click on Save. The Save As dialog box appears.
Step-3 : Type a name in the filename text box.

Step-4 : Click on Save button.

3. Follow these steps to close WordPad :

Step-1 : Click on WordPad button. A menu appears.

Step-2 : Click on Exit option.
It will close the WordPad Window.

@O



Chapter-8

mo aw

<4—— Menu bar
< — Drawing area
AN Turtle

— R —— .| (5]

=aft Trace,

Paues | Sais—f= Command buttons
Skp Pl sl

Command box

\ —tSesettiat— Input box

1.(a)2.(c) 3. (a) 4. (c)

1. LOGO 2. Commander 3. Command Input Box 4. Home, turtle 5.
Primitive

1.(b) 2. (a) 3. (d) 4. (¢)

LOGO stands for Language of Graphics Oriented. Using LOGO, we can
draw and also do calculations.

2. The eight command buttons, nemaely Halt, Pause, Stop, Trace, Status,
Reset, Execute and Edall make it easier for you to work in MSW LOGO.

3. In the center of the main screen there is a small triangle called turtle
which is an on-screen cursor. Turtle can be given movement and drawing
instructions and is used to programmatically produce line graphics.

4. The MSW LOGO window has two main parts : MSW LOGO Screen and
Commander Window.

Computer-4

Chapter-1

oNw

1.(a)2.(a)3.(c)4.(a)

1. super 2. storage devices 3. control unit 4. input 5. multiuser
1.T2.T3.F4.T5.T6.T

1. A computer performs its functions in three basic stages :

- Receives data and instructions through input devices.

- Processes data as per instructions through processing device.

- Output results of processing through output devices.

This cycle of operations is also known as Input—Process—Output cycle.

2. The computer has become very important nowadays because of it's
accuracy, speed, efficiency, utility and ease of use. Otherwise in order to

complete those tasks manually much more time is required.

3.

Processing

Information

Input Devices

Instruction

Main Storage

Input—Process—Output Cycle



4. Output devices recieve the processed data. Then these devices help us to
display the processed data or result.
5. Input devices feed the data into the system unit.

Fun Time

1. MOUSE 2. CPU 3. SUPER COMPUTER 4. PERSONAL COMPUTER 5.
LAPTOP 6. MONITOR 7. INPUT 8. OUTPUT 9. PROCESSING

Chapter-2

A. 1.(b)2.(a)3.(b)

B. 1. Laptop 2. tower 3. kbps 4. dot-matrix

C. 1.T2.T3.F4.F

D. 1. There are two types of computer available in the market— laptop and
desktop.
2. A branded computer is made by a well-known manufacturer and has the

manufacturer's label on it. Whereas assembled computers contain hardware
components manufactured by well-known companies.
3. Computer peripherals are the hardware parts which are not the necessary
parts of computer system but are useful is some other way. For example : a
printer is used to take printout on paper.
4. Software is used to run the hardware of the computer. Some anti-virus
software are used to protect the system against viruses.

Fun Time

1. DESKTOP 2. ASSEMBLED 3. PROCESSOR 4. TOWER TYPE 5. PEN
DRIVE 6. MODEM 7. SOFTWARE

Chapter-3

A. 4,1,2,3

B. 1. Random Access Memory 2. Gigabyte 3. Erasable Programmable Read

only memory

1.(b) 2. (c) 3. (a)

1. binary 2. temporary 3. cache 4. secondary 5. memory cards

1.T2.F3.T4.FS5.T

1.(e)2.(a)3.(d) 4. (e) 5. (b)

1. The primary memory can be broadly classified two categories :

ROM and RAM

2. Computers work with only two digits— 0 and 1. These are called binary
digits or bits (binary digits). A group of 8 bits make up a byte. It is denoted
by B. So, 1 byte = 8 bits.

3. It is a part of a unit called the hard disk drive or hard drive. The hard
drive is another common device, which stores data. It can store large
amounts of data.

OmE o0
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Chapter-4

A.
B.

C.

1.(b)2.(c)3.(a)4. (c)

Windows 2. double click 3. quick access toolbar 4. ribbon 5. minimize,
maximize, close

1.T2.F3.T4.F5.T

1. We can easily open an application available in computer by using Start
button. Follow these steps to do this :

Step-1: First, click on Start button.

Step-2: Select All Programs option to view a list of the programs available
on your computer.

It shows a list of programs. All Programs button changes to Back button.
Step-3 : Click on the application you want to open.

A sub-menu may also appear.

Step-4 : Click on the desired option from sub-menu.

2. Follow these steps to minimize a window :

Step-1 : Click on minimize button in the window.
The window reduces in an icon on the taskbar.

Step-2 : To re-display the window, click on the icon of the window on the
taskbar.

3. The program window on which we are working is called Active window.
It appears in front of all other windows and displays a dark title bar.

> Just click on the icon on the taskbar to display the window you want to
work with.

It will bring the desired window in front of all other windows.

1. Some fascinating features of Windows-7 are the following :

> [t has a new start screen, colourful and attractive GUI.

> File and folder management has become easier in Windows 7.
> Faster speed than the previous versions of Windows.

> Ease of access to various programs directly from desktop.

> Advanced security tools are available in Windows 7.

2. These are the mini-programs on the desktop. For example; clock or
calendar, a game, picture slide show, etc.

Generally gadgets are displayed on the right side of the screen.

3. The most useful feature of a Graphical User Interface (GUI) is Windows.
It is a rectangular shaped area which allows us to work on the application.
We can open multiple windows simultaneously. When the two windows
overlap, the lower window becomes invisible.

Chapter-5

A.
B.

1. (b) 2. (a) 3. (c)
1. desktop background 2. picture position 3. themes, screen saver, color 4.
gadgets

Gz



)

D.

e

1.T2.F3. T4 F5.T

1.(c)2.(a)3.(d) 4. (e) 5. (b)

1. The background picture, which covers the whole screen of desktop is
called desktop background. It is also known as wallpaper.

2. An animated image, that is activated on computer screen, when your
computer is left idle for sometime is called screen saver.

3. The small programs like, clock, calculator, calendar, etc. are called
gadgets. These perform a specific function.

1. Follow these steps to change the wallpaper :

Step - 1 : Right-click at anywhere on the desktop. It will open a menu.

Step - 2 : Choose Personalize option of this menu.

It will open the window given alongside on your desktop.

Step - 3 : Click on the Desktop background option available in this window.
A new window will appear.

Step - 4 : Select the desired option from picture location drop-down list.
Here, we are choosing Windows' Desktop Backgrounds.

Step - 5 : Choose the picture of your choice from the available options.

You can also adjust the position of your picture using Picture Position
option.

Step - 6 : Now, click on the Save Changes option.

The wallpaper of your computer changes according to your choice.

2. Follow these steps to add a gadget :

Step - 1 : Right click anywhere on the desktop.

A menu will appear.

Step - 2 : Click on the Gadget option of this menu.

Step - 3 : Click on desired gadget.

You can click on the show details to see the description of the gadget.

Step - 4 : Right-click on the gadget you want to add.

Step - 5 : Now, click on Add.

You can also add a gadget by double-clicking on it.

3. Follow these steps to set screen saver :

Step - 1 : First, open the Personalization window.

(Use the steps 1 to 4 from previous section)

Step - 2 : Click on Screen Saver option.

The screen saver setting dialog box appears.

Step - 3 : Choose any screen saver from the screen saver list box.

You can also take a preview of the selected screen saver on the computer
screen by clicking on Review button.

Step - 4 : Click on the write up and down arrow buttons to set the number of
minutes in the wait box. This is the idle time of computer after which the

D)



screen saver starts.
Step - 5 : Click on the Apply button.
Step - 6 : Now, click on the OK button.

If the system remains idle for the number of minutes you specified in step-5,
the screen saver starts automatically.

4. Follow these steps —
Step-1 : Open the personalization window.

Step-2 : Scroll down the window to view the themes which are available in
Windows-7.

Step-3 : Click on the theme you want to use.

Chapter-6

A.
B.

C.

1.(a)2.(c) 3. (b)

1. processing 2. quick access toolbar 3. working area 4. scroll bar 5. next
line

1.T2.F3.F4.T5.F

1. A special application software used to type and edit text on a computer is
called the Word Processor.

2. Following are the main features of a word processor :

> The document can be saved, opened and changed as many times as
needed.

> Documents can be beautifully formatted.

(a) Left, right, top and bottom margins in the page can be set.

(b) Font, style, size and colour of the text can be set as desired.

> Pictures and drawings can be inserted in the document.

> Whole or a part of the document can be printed any number of times.

3. Elements of MS Word Windows are the following :

Title bar, Quick Access Toolbar, Ribbon, Insertion Point, Office Button,
Work Area, Scroll Bar, Status Bar

1. Follow these steps to start Word 2007

Step - 1 : Click on Start button.

Step - 2 : Click on All Programs option.

Step - 3 : From the All Programs menu choose Microsoft Office.
Step - 4 : Now, in this menu click on Microsoft Office Word 2007.

2. You can open the already saved document on the screen by following
these steps :

Step -1 : First, click on the Office button.

Step -2 : Click on the Open option.

The Open dialog box appears.

Step - 3 : Click on the file you want to open.



Step - 4 : Now, click on the Open button.

F. 1. Quick Access Toolbar : It is present on the left side of title bar. This
helps to perform common tasks with just one click.
2. Entering Text in Word : We can enter text within the document by
pressing the keys on the keyboard. The typed text will appear in the working
area where the cursor appears.
The text typed using the keyboard will appear in the document where the
cursor flashes on window.
3. Scroll Bar : It appears along the right edge and bottom of a window.
When text, graphic or icons on the window take up more space than the area
we can see, click on a scroll bar can move the document up, down, left and
right on a window.

Chapter-7

A. 1.(b)2.(c)3.(b) 4. (a)

B. 1. slide 2. slide show 3. placeholder 4. MS-Power Point, slide show 5.
Outline, slide

C. 1.(c)2.(e)3.(a)4.(b)5.(d)

D. 1.F2.T3.T4.F5.T

E. 1. A presentation is a systematic display of text along with graphics, movies,
sounds, etc. It is a structured delivery of information.
2. A slide show is a very useful tool for sharing, learning and teaching.
These are the steps to run a slide show—
Step-1 : Click on the Slide Show tab on the Ribbon.
Step-2 : Click on the from Beginning from the start slide show group.

or Press F5

It displays the slides on full screen.
3. Follow these steps to insert a new slide in your presentation :
Step-1 : Click on the Home Tab on the Ribbon.
Step-2 : Click on the New Slide from slides group. A list appears.

F. 1. Follow these steps to insert WordArt text :

Step-1 : Click on the Insert tab available on the Ribbon.

Step-2 : Click on the WordArt from Text group.

It displays a gallery with different WordArt Styles.

A WordArt text box will appear on a slide.

Step-3 : Type your desired text in the text box and click outside it.

2. Follow these steps to add the text :

Step-1 : First select the slide in which you want to add a Text Box.
Step-2 : Click on the Insert tab available on the Ribbon.

Step-3 : Now, click on the Text Box from the Text group.

Step-4 : Drag your mouse to draw a text box where you want to add text.
Step-5 : Type the desired text using the keyboard and click anywhere
outside the box

3. Follow these steps to open a saved presentation :
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Step-1 : First click on the Office button
Step-2 : Choose Open option from the list.

The Open dialog box appears.
Step-3 : Select the desired file from the Open dialog box.

Step-4 : Now, click on the open button.
This will open the desired presentation file in the PowerPoint window.

Chapter-8

A.
B.

C
D.

1.X2.V3. X4 X5V 6V 7.V/8X9.V

1. (b) 2. (a) 3. (¢)

1. number 2. 30, backward 3. CLEARSCREEN 4. SETH

1. The center of the main screen is called the HOME of the turtle. It is the
starting point of drawing.

2. DRAW command is used to make the turtle ready to draw lines by
moving on the screen.

3. This command is used to point the turtle's head in any direction without
using the RT or LT commands. Figure given alongside shows the directions
towards which the turtle's head can point.

Chapter-9

A.
B.

C
D.
E

LV2.V3. X4/ 5X6X7.4/8X

1. (c) 2. (b) 3. (b) 4. (b)

1. TO 2. commands 3. END 4. EDIT 5. Erase

1.T2.T3.F4.F5.T

1. A procedure is a way to make the turtle remember a set of commands. The
procedure is useful for tasks where a specific set of commands is to be
reused. This set of commands is given a name and can be recalled whenever
needed.

2. To run the procedure, give the procedure name in command input box and
press the Enter key.

3. Sometimes, you need to delete a saved procedure. Just follow these steps
to delete a procedure :

Step-1 : Type ERASE “SQUARE”.

Step-2 : Press Enter key.

One can also erase using the Erase option from the File menu.

4. Rules for naming the procedure:

> The name of a procedure can be made up of letters of the alphabet,
numbers or any other symbol.

> The name of a procedure should not have a blank space anywhere in it.
> The name of a procedure should not be any LOGO command.

> The name cannot include arithmetic operators +,—, ", and /.



> To begin a procedure, type the word To and a name for the procedure. For
example,

Correct names : Newhut, Circle 81, India, etc.

Incorrect names : New hut, +11 Delhi, PR, etc.

Computer-5
Chapter-1
A. 1.(a)2.(a)3.(a)
B. 1.ENIAC2. first generation 3. personal computer 4. third 5. thinking power
C. 1.(b)2.(a)3.(e)4.(c)5.(d)
D. 1. The earliest known computing device in use even today, is the abacus. It was

developed in Egypt in about 450 BCE and was later perfected in China in the
12th century. An abacus consists of a wooden frame having a middle bar
dividing the frame into two sections.

2. ENIAC was the full fledged electronic computer. ENIAC worked on
vacuum tubes. [t needed a whole room to fit into.

3. Presently, there are five generations of computers. They are discussed in
terms of

> The technology used by them (hardware & software)

> Computing characteristics

> Physical appearance, &

> Their applications.

4. These computers are supposed to have thinking power, i.e., they will have
artificial intelligence. They aim to bring machines to reason logically and
with real knowledge of the world and make decisions like human beings.

1. First Generation

Features : 1. These machines used vacuum tubes. 2. Used programming in
mechanical language.

Limitations : 1. Very high cost 2. Very big in size

2. Second Generation

Features : 1. These machines used transistors 2. Power consumption was
comparatively low.

Limitations : 1. Speed was very slow 2. High temperature

3. Third Generation

Features : 1. These machines used Integrated circuits 2. Small in size
Limitations : 1. Required highly sophisticated technology is required for
manufacturing of Microprocessors 2. Magnetic drums used as medium of
storage

4. Fourth Generation

Features : 1. Could be easily placed on small table 2. Very low cost
Limitations : The latest technology is required for manufacturing of
Microprocessors 2. High level language is used in programming
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Chapter-2

A 1L.X2 V3. X4 X5X6V 7V 8Y
B. 1.(c)2.(a)3.(c)4. (b)
C. 1.(b)2.(d)3.(a)4.(e) 5. (c)
D. 1.1PO 2. versatile 3. patients 4. digitizing 5. Internet
E. 1. A computer is used at home to do many jobs. Some of them are listed
below.
1. Listening to music
2.Playing games
3. Typing letters
4. Sending and receiving e-mails
2. Uses of Computer in schools :
1. Computers help teachers to teach the computer as well as other subjects.
2. Computers help teachers to prepare time-table and results.
3. Computers help to keep the record of fees.
4. Computers help to keep the book-record in the school library.
3. Computers are helpful to doctors in the following ways :
1. Computers are used to store information of patients.
2. Itisused to keep medical records of patients and their treatment.
3. Testing samples of blood, urine, stools, etc. for different diseases is done
using computer.
4. Computer is used to take X-rays, ultrasounds, and other tests that help
doctors to diagnose diseases.
5. Checkup of eyes is also done using the computer.
4. Three uses of a computer in science and technology :
1. Computers help in research and collection of data.
2. Itis helpful in sending space missiles and launching rockets.
3.Making space equipment has become easier due to the computers.
Chapter-3
A. 1. desktop 2. folder 3. drag and drop
B. 1.Ctrl +C 2. Ctrl + V 3. Shift + Del
C. 1.(b)2.(c)3.(b)
D. 1.icons 2. Windows 7 3. sub-folder 4. highlighted 5. move
E. 1.F2.F3.T4.TS5.F
F. 1. A folder is used to store a group of files with data on same/different

subjects. Folders not only store files, but they also can hold other folder. A
folder within a folder is called a sub-folder.

A folder is used to store a group of files whereas any piece of information
stored in the computer is in the form of a file.

2. An essential concept to understand files and when working with
computers is the system for organizing, storing, and locating your files in
the operating system. Like in the real world where paper records are kept
organized by means of a filing system, in computers, folders are used to



store files that would otherwise be all over the place.

3. While working or managing with files and folders, the first step is to
select the file or folder you want to work with. The selected file or folder
gets highlighted on the screen.

1. Follow these steps to select multiple files :

Step- 1 : Open the folder containing the files to be selected.
Step- 2 : Click on the file you want to select.

Step- 3 : Press and hold down the Ctrl key as you click each file you want to
select.

2. Follow these steps to select all files in a folder :

Step- 1 : Open the folder containing files.

Step- 2 : Click on organize.

A menu will appear.

Step- 3 : Click on the select All option in menu.

All the files get selected in the folder.

3. Follow these steps to copy a file or folder :

Step- 1 : First, open the folder containing the file you want to copy.
Step- 2 : Select the file or folder you want to copy.

Step- 3 : Right-click the mouse and click the copy option.

Chapter-4

A.

B.
C.
D

1. save 2. undo 3. copy 4. bold 5. list with numbers 6. justify 7. cut 8.
underline

1. (b) 2. (a) 3. (b)

1. Home tab 2. font size 3. black 4. highlighted 5. bullet

1. Selecting Text : In order to change the format of the text you just typed, it
must be first highlighted i.e. selected with the mouse cursor.

To select using the keyboard, place the cursor to the left of the first character
to be selected. Now, hold down the Shift key and press the right arrow key
till the desired portion of text is selected.

2. Copy and Paste Text : The Copy and Paste commands of MS-Word can
be used to copy a piece of text from one location in a document and paste it
to another location. The Cut command allows you to remove selected text
from the document. The Copy command creates a duplicate of the selected
text, leaving the original text unchanged. The Paste command pastes the
copied text at the location where the cursor is placed.

3. Creating List with Bullets : Follow these steps to perform this :

Step- 1 : Select the items of list.

Step- 2 : Click on the Home tab.

Step- 3 : Now, click on the drop-down list arrow on Bullets button in the
Paragraph group.

Step- 4 : Select the bullet of your choice by clicking on it.



m

The bulleted list is ready.

1.F2.T3.T4.F5.T

1. In MS Word 2007, the ribbon replaces all the tools and tabs. The ribbon
contains two parts— Tabs and Groups. Each tab contains commands
arranged in different groups to perform specific tasks.

2. While typing or editing a document, sometimes we need to type a word or
sentence many time. MS Word 2007 provides us commands to use the same
word or sentence any number of times very easily without typing it again
and again. We can also shift words or sentences from one place to another in
the document.

3. Undo command : The Undo command, on the Quick Access Toolbar, is
used to undo anything you done in Word, which includes formatting the
text, moving the blocks, typing and deleting the text, formatting the text, etc.
Redo Command : If you undo something that you did not mean to, you can
use Redo command to set things back as they were.

Chapter-5

A.
B.

C.

1. (b) 2. (c) 3. (b) 4. (a)

1. insert 2. shapes 3. From CD audio track 4. Loop until stopped 5. Rehearse
timings

1. insert tab 2. Format tab 3. Autoshapes 4. Media Clips group 5. Sound
Clips group

1. We can change a coloured Clip Art into a black and white drawing by
using Recolour option (drop down list) of Format Menu. Several other
options are also available in this drop down list.

2. Follow these steps to insert movie clips in your presentation :

Step-1 : First click on the Insert tab.

Step-2 : Choose Movies from Media clips group.

A submenu shows you two ways to add a video clip, one as a Movie from
File, and one as a Movie from Clip Organizer.

3. Yes, we can record our own voice as a sound clip by using Record Sound
option.

4. The Rehearse Timings feature is present in the Set Up group in the Slide
Show tab.

You can record timings automatically as you rehearse presentations. You can
adjust the timings you have already set and then rehearse the new ones.

5. To add transition to slides in a presentation, select the slide(s) in the
outline view.

Step-1 : Click on the Animations tab.

Step-2 : Click on the drop-down arrow in the Transition to This Slide tab.
Step-3 : A drop-down menu opens up with several options of transition to
choose from.

Step-4 : Clicking on the Transitions Sound option opens a drop-down
menu with several options to choose from.

Step-5 : You can even control the transition speed from slow, medium, and



fast from the drop-down menu in the Transition Speed option.
Step-6 : Choose the speed and click on the Apply to All option. The
transition gets applied to all the slides.

Chapter-7

A.

B
C
D.
E

1. Do yourself

1.(c)2.(c)3.(a)4. (b)

1. algorithm 2. processing 3. process symbol 4. conjunction 5. debugging
1.(d)2.(c)3.(b)4.(e) 5. (a)

1. In an algorithm, we write the tasks involved in doing a job in a stepwise
order. We take care of all the things which are needed to perform the job, by
writing an algorithm.

Let us take an example to write an algorithm to prepare tea.

The steps required are :

Step- 1 : Put tea bag into a cup.

Step- 2 : Fill the required amount of water in the kettle.

Step- 3 : Boil the water in the kettle.

Step- 4 : Pour the boiling water in a cup.

Step- 5 : Add milk and sugar.

Step- 6 : Stir with spoon.

Your tea is ready to drink.

2. The following are some guidelines to be followed in flowcharting :

(a) In drawing a proper flowchart, all necessary requirements should be
listed out in logical order.

(b) The flowchart should be clear, neat and easy to follow. There should not
be any room for ambiguity in understanding the flowchart.

(c) The usual direction of the flow of a procedure or system is from left to
right or top to bottom.

(d) Only one flow line should come out from a process symbol.

(e) Only one flow line should enter a decision symbol, but two or three flow
lines, one for each possible answer, should leave the decision symbol.

(f) Only one flow line is used in conjunction with terminal symbol.

(g) Write within standard symbols briefly. As necessary, you can use the
annotation symbol to describe data or computational steps more clearly.

(h) If the flowchart becomes complex, it is better to use connector symbols
to reduce the number of flow lines. Avoid the intersection of flow lines if
you want to make it more effective and better way of communication.

(1) Ensure that the flowchart has a logical start and finish.

(j) It is useful to test the validity of the flowchart by passing through it with
a simple test data.

Chapter-8

A.
B.
C.

1. modalities 2. multimedia 3. installed 4. sound card, speakers
1. (b) 2. (a) 3. (b)
1.T2.F3.T4.T5.F
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D. 1. The multimedia is a collection of text, graphics, sounds, animations and
video clips. Multimedia involves modalities of media.
2. Following elements are essential for a multimedia system :
> Pentium Microprocessor
> A CD-ROM drive for playing CD
> A sound card and speakers for producing sound
> Colour monitor to display video
3. Multimedia programs are generally used for —
> giving training to students and workers. > educational purposes.
> playing games. > creating advertisements.
> playing music and movies. > research and development.
4. The Windows Media Player program works like a CD Player, and is
generally used to listen to songs or watch movies.

Chapter-9

A. 1. Internet Service Provider 2. World Wide Web 3. File Transfer Protocol 4.
Modulator Demodulator

B. 1.(b)2.(a)3.(c)4.(b)

C. 1.(c)2.(e)3.(a)4.(b) 5. (d)

D. 1. email 2. Internet 3. website 4. web browser

E. 1. The Internet began as ARPAnet in 1958, a U.S. Department of Defence
project to create a nationwide computer network that would continue to
function even if a large portion of it were destroyed in a nuclear war or
natural disaster.
During the next two decades, the network that evolved was used primarily
by academic institutions, scientists and the government for research and
communications. The appeal of the Internet to these bodies was obvious, as
it allowed disparate institutions to connect to each others' computing
systems and databases, as well as share data via E-mail.
The nature of the Internet changed abruptly in 1992, when commercial
entities offered Internet access to the general public for the first time. This
change in focus marked the beginning of the Internet's astonishing
expansion.
2. We can get a lot of information on the topics of our interest from Internet.
> We can send and receive messages using e-mail facility of Internet.
> Internet can be used as a medium for advertising products and services.
> We can use Internet to purchase various items.
> We can book air and train tickets through Internet.
> By using the Internet, we can communicate instantly with people in far
off places.
3. E-mail or Electronic mail is a service available on the Internet. It allows
us to send messages to anyone around the world. It is the fastest way
available of sending and receiving written messages.

F. 1. World Wide Web (WWW) : It is the collection of millions of pages of

information available on the Internet. It contains millions of web sites,

D)



which provide information about different things. It can be in the form of
text, animation, picture, etc.

2. Internet : Internet is the biggest network of computers around the world.
All these computers are connected to each other by telephone wires, by
means of cables or some wireless media of communication.

3. Hyperlinks : A hyperlink may be a text or a picture. When you move
your mouse pointer over a hyperlink, the mouse pointer generally takes the
shape of a hand. If you click on a hyperlink it leads you to the part of the
webpage to which it is linked.
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Chapter-1

(A)

(B)
(©
(D)
(E)

1. Animation is a technique of giving a film or a character the appearance of
movement.
Architects design buildings and houses on computer.
Computers are used in shops for preparing bills.
Robots are machines controlled by computers.
(c) 2.(a) 3.(a) 4.(b)
tickets 2. doctors 3. ATM’s 4. Shopkeepers 5. architects 6. Satellites
V2V3.X4/5X
Computers are used athome for :

playing games.

listening to music.

watching movies.

writing letters.

storing addresses and telephone numbers.

keeping track of monthly expenditure.

gathering information on any project.

performing calculations, and enhancing grammar.
2. The pictures can be modified on a computer to suit the requirements of
the film. Special effects such as sequence of a battle, an earthquake, or a
fire can be created using a computer.
3. Computers are used in school for :
> preparing lessons.
> teaching different subjects using CDs.
> preparing report cards.
> preparing projects.
4. Robots are machines controlled by computers. They look like humans.
They can do some tasks that humans cannot do. Robots are used in almost
every field.
> Robots handle chemicals that are dangerous for humans to touch.
> Robots can go to dangerous places, that is, deep underwater to search
for sunken ships or look for mineral deposits.
> Robots can go into active volcanoes.
> Robots help explore Mars and other planets.
> Robots help doctors to perform operations.
5. Use of computers in space technology :
> Computers are used to monitor and control the proper functioning of
space equipment, satellites, etc.
> A number of satellites are linked to computers, which provide a lot of
important information for space research.
> Space shuttles and rockets, which take man into space, are controlled by
computers.
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(A)

(B)
©
(D)
(E)

()

1. Minimize, maximize and close 2. Control Panel 3. Category view 4.
Category view, large icons view, small icons view

1. (¢)2.(a)3.(c)4.(b)

1. back 2. maximize 3. title bar 4. categories 5. theme
1.V2V/3.X4X5V

1. Customize windows and control various devices attached to our computer
system. We can use it to add or remove programs, change display settings of
monitor, change settings of mouse, etc.

2. Follow these steps to move a window anywhere on the desktop :

Step 1 : Click on the top left corner of the window.

A menu appears.

Step 2 : Now, click on the Move option.

Using arrow keys, move the window to the desired location and press the
enter key to finish it.

3. Control panel of Windows is just like a command centre of the computer
system. We can customize and control various devices attached to our
computer system. We can use it to add or remove programs, change display
settings of monitor, change settings of mouse, etc.

4. Changing the mouse pointer type—

Step 1 : Click on the Pointer's tab available in Mouse Properties dialog
box.

You will see a list of different types of pointers against the different types
of windows operations.

Step 2 : Select the desired Pointer Type from the customize list.

Step 3 : You can also click on the Browse button. A new window appears.
It displays the different types of available pointers.

Step 4 : Choose the pointer shape of your choice.

Step 5 : Click on the Open button.

You see the changed pointer shape in place of the original pointer
shape.  in the customize list.

Step 6 : Now, click on Apply button. The desired changes come into effect.
Step 7 : When you completed the changes according to your choice, click
on the OK button.

1. Follow these steps to resize a window :

Step 1 : Click on the top left corner k 'the window.

A men [ ippears.

Step 2 . Click on the size option of this menu. Now, by using arrow keys,
resize the window to the desired size then press the enter key to finish it.
You can also resize it by bringing the mouse pointer to anyone of the four
borders of the window and drag the mouse by holding the border to change the
size of window.

2. Follow these steps to customize the appearance of windows of your
computer.

Step 1 : First open the Control Panel window and click on the Appearance
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and Personalization option.
A list of options will be displayed.
Step 2 : Click on the Personalization option.
Step 3 : Choose the desired. Theme and click to apply it to your computer.
The applied theme changes the window colour, screen saver, desktop
background and sounds of your system.
3. To configure the double-click speed, drag the slider to the left or right.
> dragging the slider to the left increases the time interval between
double-clicking.
> dragging the slider to the right decreases the time interval between
double-clicking.
Click on the Apply button and then click OK button to save the changes
you have made.
Chapter-3
(A) 1. The ready-made picture gallery of MS-Word is Clip-Art.
2. Word Art is a feature which allows to create dynamic text with ready-
made effects.
3. Toggle case
(B) 1.(b)2.(c)3.(a)4.(b)5.(a)6.(c)
(©) 1.(e)2.(c)3.(a)4.(b)5.(d)
(D) 1. ready-made 2. Word Art 3. aligning 4. selected text, document
5. toggle 6. header and footer 7. capitalizes
(E) 1. Follow these steps to change the case of any text :
Step 1 : First select the text to be converted.
Step 2 : Click on the Home tab.
Step 3 : Click on Change Case from the Font group and select the desired
case from the list.
2. Information such as title and date of creation is needed at every page of
the document. It can be specified in the header or footer of the page.
> A header is printed on the top margin.
> A footer is printed at the bottom of the document.
3. Follow these steps to insert Word Art text.
Step 1 : Click the Insert tab on the ribbon.
Step 2 : Click on the WordArt from Text group.
The Word Art gallery appears.
Step 3 : Select the desired style.
4. Follow these steps to insert symbols :
Step 1 : First of all place the cursor where you want to insert the symbol.
Step 2 : Click on the Insert tab.
Step 3 : Click symbol from symbol group.
It will display a list of symbols.
Chapter-4
(A) 1. The horizontal data is called row. 2. Insert Above 3. Table format
(B) 1.(b)2.(a)3.(a)4.(b)
(C) 1. row 2. table style 3. layout 4. merging 5. Design



D)
(E)
)

(G)

1.(d) 2. (e) 3. (a) 4. (b) 5. (¢)

L.V2.V3 X4/ 5V

1. Word-2007 contains an inbuilt facility for changing the look, colour and
design of the borders of a table. It is called Table styles. It is present in
Design tab on the ribbon. This tab appears only when a table is inserted.

2. Follow these step to split cells :

Step 1 : Select the cell or multiple cells that you want to split.

Step 2 : Click the Layout tab.

Step 3 : Click Split Cells from merge group.

Step 4 : The Split Cells dialog box appears. Specify the number of columns
and rows in which you want to split the selected cells into.

Step 5 : Click OK. Cells get split up.

3. Follow these steps to insert a table :

Step 1 : Click on the Insert tab on the ribbon.

Step 2 : Click on the Table button from the Table group. A drop down list
appears.

Step 3 : Drag the mouse pointer starting from first box until you highlight
the number of rows and columns, you want the table to contain.

Word previews the table as you drag over the cells.

1. As above

2. You can simply insert text in a table with the help of keyboard.

Step 1 : Click on the cell where you want to enter the text. Then type the
text.

Step 2 : Repeat Step -1 until you finish entering all the texts for the table.

3. You can select table, cells, rows and columns in a table to perform
editing tasks and apply formatting to all the selected areas of the table.

To select a range of cells

> (Click and drag the mouse over the cells that you want to select.

> Now, release the mouse button to select cells.

To select a single cell

> You can triple-click the cell to select everything on it.

To Select an entire row

> Take your mouse near the border of row (mouse pointer changes into an
arrow) and click on it . The entire row gets selected.

To select an entire column

> Take your mouse near the top of the border (mouse pointer changes into
an arrow) of the column and click on it.

The entire column gets selected.

4. Follow these steps to add row to a table :

Step 1 : Click on the place in the table where you want to add another row.
Step 2 : Click on the Layout tab.

Step 3 : You can click Insert Above or Insert Below to add new row,
according to your requirement. Alternative you can right click on the
location where you wish to add a row & select Insert— Insert Rows Above
or Insert Rows Below.
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Follow these step to add column to a table :

Step 1 : Place cursor in the table, where you want to add another column.
Step 2 : Click on the Layout tab.

Step 3 : You can click Insert Right or Insert Left to add new columns,
according to your requirement. Alternative you can right click on the
location where you wish to add a column & select Insert— Insert columns
to the left or Insert columns to the right.

5. Follow these step to change the height of a row :

Step 1 : Place the mouse pointer over the bottom edge of the row to be
changed to a new height.

Step 2 : Drag the row edge to a new position.

Step 3 : Release the mouse button. Word - 2007 adjusts the row height
according to your choice.

6. Follow these steps to change the width of a row.

Step 1 : Place the mouse pointer over the edge of the column you want to
change to a new width.

Step 2 : Drag the column edge to a new position.

Step 3 : Release the mouse button. Word adjusts the column width
according to your choice.

7. Follow these steps to merge the cells :

Step 1 : Select the cells to be merged.

Step 2 : Click on the Layout tab.

Step 3 : Click Merge cells from the merge group.

The cells get merged.

Chapter-5

(A)
(B)

1. Spreadsheet 2. Three 3. Open and Save 4. Ribbon
1. (b)2.(c)3.(b)4.(b) 5. (¢c)

(C) 1. spreadsheet 2. cell 3. tabs 4. Quick Access 5. close option
D) 1.(d)2.(e)3.(DH4.(a)5.(c) 6. (b)

(E)

1. MS-Excel is commonly used electronic spreadsheet software.

The basic work area in an MS-Excel 2007 workbook is the worksheet
which is also known as a Spreadsheet.

The term spreadsheet refers to an application software such as MS-Excel,
which allows tabular work with numbers and text including mathematical
calculations and graphic operations.

2. MS-Excel is used mainly for manipulating numeric data. We can use it
for many other operations like :

> Using Numbers : MS-Excel can be used to easily and quickly tally
sales figures, figure averages and summarizing performance numbers for
entire department.

> Organizing Data : MS-Excel provides various sorting operations to
organize the entered data in a proper manner.

> Creating Electronic Worksheets : MS-Excel provides an easy and
efficient way of maintaining data in worksheet.

> Formulae and Functions : MS-Excel contains various built in



functions to work on data. We can perform any kind of mathematical
calculations, from the simplest equation to the complex formula.

3. The basic work area in an MS-Excel 2007 workbook is the worksheet
which is also known as a Spreadsheet.

The term spreadsheet refers to an application software such as MS-Excel,
which allows tabular work with numbers and text including mathematical
calculations and graphic operations.

4. In an Excel worksheet, we can enter data in the form of numbers or text
by just clicking on a cell and begin typing.

The data we type appears in the active cell and in the formula bar.

While typing two buttons (cancel and enter) appear to the left of the
Formula Box. The cancel button is used to cancel data entry before
pressing the Enter key. We can also use the ESC key. The Enter button is
used to complete the data entry.

5. Follow these steps to save your workbook.

Step 1 : Click on the Office button.

A menu will appear.

Step 2 : Click on the Save or Save as button. Save as dialog box will
appear.

Step 3 : Click on the File Name text box and type a name for your file.

Step 4 : Click on Save button.

The Excel saves your workbook and the new file name given by you
appears on the title bar.

Chapter-6

(A)

(B)
©
(D)
(E)

(F)

1. In Quick Access Toolbar 2. Worksheets tabs 3. Deleting row, deleting
column 4. Range 5. Worksheet tabs

1. (a) 2. (c) 3. (c) 4. (b)

1. Selection 2. Editing 3. Click, double click 4. deleted 5. cell
.V2V/3X475X

1. If you wish to perform a function on a group of cells, you must first
select those cells by highlighting them.

2. To select a cell range using mouse, follow these steps :

Step-1 : Point your mouse to the first cell of the range to be selected.

Step-2 : Drag by holding down the left mouse button until all the required cells
are selected.

3. Moving the data allows you to re-organize the data in your worksheet.
When you move the data, the data disappears from its original location.
Copying the data allows you to repeat the data in your worksheet without
having to retype the data. When you copy the data, the data appears in both
the original and new locations.

4. You can move around from one worksheet to another by clicking on the
tabs located on the bottom of the worksheet.

1. Edit menu 2. Edit menu 3. Insert menu 4. Format menu 5. Format menu

Chapter-7

(A)

1. By using start button 2. Outline view 3. Normal view, Slide Sorter view,



(B)
©
D)

(E)

Slide Show view 4. Title slide, Title and Content 5. F5

1. (c) 2. (b) 3. (a) 4. (b)

1. PowerPoint 2. Blank 3. Templates 4. Outline 5. full screen

1. To start Power Point 2007 program, follow these steps :

Start — All Programs — Microsoft Office & Microsoft Office Power
Point 2007

2. Follow these steps to create a presentation using the Installed Themes.
Step 1 : Click on the Installed Themes option from the left pane.

Step 2 : Choose the desired Installed Themes for your presentation.

Step 3 : Click on create button.

The desired Installed Theme type presentation slide gets created.

3. Click on the slide show icon on the status bar to have on-screen
presentation.

OR

Follow the given steps.

Step 1 : Click on the Slide Show tab on the ribbon.

Step 2 : Click on From Beginning in the Start Slide Show group.

4. Step 1 : Select the slide whose layout is to be changed by clicking on it.
Step 2 : Click on Home tab.

Step 3 : Click on Layout from the slides group.

Step 4 : Now, choose the layout you want from the available options.

The layout of the selected slide gets changed.

1. A Power Point presentation consists of a number of slides. A slide
represents a page in a presentation. The information contained by slide can
be in the form of text, images, animations, sound and video.

2. MS - Power Point is a presentation software. It is used to create and edit
presentation for slide shows, meetings and web pages. It is a presentation
software package.

3. Themes are the installed or saved presentations that contain predefined
slides, colour schemes and graphic elements.

4. Follow these steps to create presentation using Installed Templates.

Step 1 : Click on the Installed Templates option on the left pane.

Step 2 : Choose the desired Installed Template for your presentation.

Step 3 : Now, click on the create button.

The desired template type presentation gets created with many slides.

Chapter-8

(A)

(B)
(A)

B)

1. Internet Explorer, Mozilla Firefox, Google Chrome

. Address Bar, Menu Bar, Command Bar, Status Bar

. Address of website is types here.

. It displays the list of websites opened previously.

. (b) 2. (b) 3. (b)

. web browser 2. address bar 3. web sites, web pages 4. search engine
. history

. Back Button : Suppose that you have opened different webpages on the
same window. This button is used to trace backwards from current page to
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previous pages.

2. Forward Button : It is used to go forward in the direction opposite to
backward. Itis available only after you click on the back button.

3. Refresh Button : Sometimes, it is likely that you are unable to open
completely a website or a webpage. You can click the refresh button to start
reloading the particular webpage or site.

4. Favorites Button : If you like something in a book, you put a mark on it.
You may find a particular website interesting. You can save the URL of this
particular site on the browser with the help of Favorites button.

1.V2X3/4 X5V

1. If you want to view a website you have to open it on the computer. To open
awebsite, youneed a software called the web browser.

There are many web browsers available these days. Some of the most popular
web browsers are :

> Microsoft Internet Explorer > Mozilla Firefox

> Google Chrome > Netscape Navigator

2. To open Internet Explorer, follow these steps:

1. Click on the Start button.

2. Click on Programs.

3. Click on Internet Explorer.

3. Standard toolbar is the toolbar which contains the most common options
needed to work while using web browser. While using web browser we use it
to navigate through the pages of web site or perform some other important
tasks.

4. The search engines are the websites which allow the user to enter the
keyword (information which you want). A search engine searches for the
information and displays a list of websites with related information.

Some of the popular search engines are :

Google http://www.google.com

AltaVista  http://www.altavista.com
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Chapter-1

(A)
(B)
©

D)
(E)

(E)

1. CPU 2. Keyboard 3. Laser printer 4. RAM 5. Byte

1. (b) 2. (a) 3. (b) 4.(b) 5. (a)

1. MICR 2. permanent 3. System software 4. hardware, software 5. 0, 1

6. trouble shooting

1. (¢)2.(d) 3. (a) 4. () 5. (b) 6. (e)

1. Field : A collection of bytes that contain data about an item is called a
field. For example, the name of a employee, his/her age, his/her post, etc.
Record : A collection of inter-related fields is called a record. For example,
an employees record may contain fields such as name, age, department,
post, salary, etc.

2. HARDWARE : The parts of computer system which you can touch or
see i.e. tangible are called the hardware. These physical units together
make the computer system.

SOFTWARE : A set of programs that controls the computer hardware
parts and makes them operational is called software. We can also say that it
governs the operations of a computer system.

3. We need storage devices to store data and information. These devices
are known as memory of a computer system.

1. Primary Memory : It is called the working memory or the main
memory of a computer system. Two major types of primary memory are
RAM and ROM.

2. Secondary Memory : One can store data for a long time using such
kind of memory. It operates at a slower rate than primary memory. Data
stored in secondary memory does not last when the computer is switched
off, so it is permanent in nature.

4. Data Hierarchy : You are aware that data means raw facts and figures,
and consists of alphabet, number, sounds, pictures, images, etc.

A computer system processes data and produces information. User can use
the information for various purposes. In a computer database, the data is
stored in the form of bits and bytes.

5. Sometimes, the mouse or speakers are not working, at other times the
display is not proper. Though fixing such problems is the job of specially
trained people, there are some problems that you too can fix. Detecting the
problems in a computer system when it is not working properly is called
troubleshooting.

6. > Check to see the power cord is properly attached or not. Check
following three connections that carry power supply.

> From Main switch to the UPS.

> From the UPS to the CPU.

> From the UPS to the monitor.

> [f the supply plugs are not correctly plugged or loose, electricity may
not flow to the system.

1. BIT : The full form of bit is Binary Digit. A computer system uses the
digits 0 and 1 to represent data. These digits show whether the computer

G



circuits are OFF or ON. A bit is therefore, represented by an electronic
circuit.

2. BYTE : The collection of 8 bits is called a byte. A byte of information is
stored by using several bits in a predefined combination called bit patterns.
ASCII and EBCDIC are two such bit patterns. The full form of ASCII is
American Standard Code for Information Interchange and that of EBCDIC
is Extended Binary Coded Decimal Interchange Code.

3. Application Software : These software consist programs that are
designed to do specific tasks such as payroll, inventory, word processing,
graphics, spreadsheets, desktop publishing, etc.

4. System Software : It controls the various resources of a computer
system. It performs the basic functions that are necessary to operate a
computer system. The Operating System (OS) is an example of system
software. Windows is the most commonly used Operating System.

Chapter-2

(A) 1. Windows Explorer 2. Libraries 3. New folder option 4. CD/DVD
burning

(B) 1.(a)2.(b)3.(a)4.(b)

(C) 1. disk drives, folders 2. contents of drive, folder 3. delete 4. delete
5. send to 6. properties

D) 1.(c)2.(a)3.(d)4.(b)5. (%) 6.(e) 7. (h) 8. (g)

(E) 1. Windows Explorer is an efficient program that is used for viewing files

and folders in MS-Window. This program is suitable for viewing files and
folders in a hierarchical order.

2. User sees [ 4] and [P] signs in front of a disk drive or folder name. A [}]
sign indicates that the folder contains subfolders. If user clicks the [}] sign,
it shows the subfolders inside, and at the same time the [}] sign changes to
[ 4] sign. This process is called expanding of a folder. If user clicks the [ 4]
sign which is in front of a folder, the expanded subfolders collapse back.

3. To group your files/folders in different ways, right-click and select
Group by option from the list and then select one of the following available
options.

Name : This option is used to organise files and folders in alphabetical
order by their name.

Data Modified : This option is used to arrange icons in the ascending
order of modification date.

The file/folder that was last opened/modified comes at last position in the
list.

Type : This option is used to organise files and folders according to their
file type. For example, when you have several folders in a drive, they will
be arranged next to each other.

Size : This option is used to organise files and folders in order of file size.
4. User can check the properties of any file or folder by using the
Properties option.

Follow the given steps to check the properties of any file/folder—

Step-1 : First select the file/folder.

€ED)
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Step-2 : Click the Properties option in Organize menu. A Properties dialog
box appears in which you can check out the properties.

5. The process of copying files to CD/DVD is called CD-burning. To burn
a CD user requires—

> a recordable CD drive or DVD drive

> a CD-burning software like Nero installed on the computer

> a blank writeable CD-ROM.

Follow the given steps to burn a CD with Nero—

Step-1 : First, insert CD in CD-ROM drive.

Step-2 : Then, open the Nero software by double-clicking its icon from the
desktop.

Click on Data CD burning option from the starting screen.

Step-3 : Click Browse button and select the required files.

Step-4 : Click Burn option to write the files in the CD.

Step-5 : After the burning process is completed data disc burning dialog
box appears. Then, click OK.

User’s data gets copied to the CD.

1. Follow the given steps to start Windows Explorer :

Step-1 : Click the Start button.

Step-2 : Click the All Programs option.

Step-3 : Click the Accessories option.

Step-4 : Click the Windows Explorer option.

OR

Click on the Windows Explorer icon on the Taskbar.

The File Explorer window appears.

2. Follow the given steps to open a file/folder—

Step-1 : Select the folder.

Step-2 : Click the open option to open all files/folders inside the selected
folders.

3. Follow the given steps to create a new folder—

Step-1 : Select the folder from the left pane.

Step-2 : Click the new folder option from Menu Control bar.

Step-3 : New folder icon appears on the right pane. Now, type a suitable
name for the folder.

4. Follow the given steps to rename any file/folder—

Step-1 : Select the file/folder.

Step-2 : Click the Rename option from Organize menu.

Step-3 : Type a new name of your choice for the file/folder.

5. Follow the given steps to open On-screen Keyboard—

Step-1 : Click the Start button.

Step-2 : Click the All Program option.

Step-3 : Click the Accessories option.

Step-4 : Click the Ease of Access option.

Step-5 : Now, click On-Screen keyboard.

It will make the On-Screen Keyboard appear.

1. This option is used to select all the files and folders, present in a folder



or drive.

2. These are use-defined collections of content that can be easily accessed
through File Explorer. It is a kind of folder that is used to manage
documents, music, pictures and other files.

3. User can use Copy option to copy a file/folder and Paste option is used
to paste it at another location.

Chapter-3

(A) 1. Find command 2. Replace command 3. Orientation 4. Margins 5. Data
Source

(B) 1.(b)2.(b)3.(a)4. (a)

(C) 1. Hyperlink 2. Mail Merge 3. Main Document 4. Mailing 5. margins

(D) 1.32.33.34.35.8

(E) 1. Hyperlinks help us to move from one page to another page by just

clicking on it. The links may be in the form of text, picture or other
document. When we move over a hyperlink mouse takes the shape of a
hand.

2. Use of hyperlink helps to move from the current document to linked
page quickly. This movement from one document to the other or from one
document to a web page is called following the link.

When you point the mouse to the hyperlink text, you see a message “Ctrl
+ Click to follow link”. Then, press the Ctrl key and click on the link.

It will open the hyperlinked document or web page for you.

3. Follow these steps to apply column formatting :

Step-1 : Select the text you want to format in columns.

Step-2 : Click the Page Layout tab on the Ribbon.

Step-3 : Click Columns from Page setup group.

Step-4 : Choose the number of columns you want from the list that opens
up. For example, two.

It will divide the selected text in the specified number of columns.

4. Suppose you want to celebrate your birthday with your friends and
relatives. For doing so you have to type an invitation to invite them. Then
you need to type all the addresses. Doing all this and saving it is a hectic
job. Use of Mail Merge feature of MS-Word makes this work very easy.
You can take help of Mail Merge feature to send the same letter to a
number of persons.

5. Given below are the requirements for the Mail Merge process.

Main Document : The document which contains letter or text that is to be
sent is called the Main Document.

Data Source : The file called Data Source stores all the addresses of the
recipients.

6. Follow these steps to replace text with some alternate text :

Step-1: Click on the Home tab.

Step-2 : Click on Replace in Editing group.

The Find and Replace dialog box appears.

Step-3 : Type the text to be searched in Find what box.

Step-4 : Type the text to be replaced in the Replace with box.
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Step-5 : Click on Replace to replace the current word.

Selecting Replace all option will replace all the occurences of the word
‘Nice’ with “Very Nice’.

Step-6 : Click on More button to get more search options.

Step-7 : Refine your search and select direction of search by selecting the
search options.

1. Follow these steps to find the text in document :

Step-1 : Click on the Home tab on the ribbon.

Step-2 : Click on Find #m- from Editing group.

The Find and Replace dialog box appears.

Step-3 : Type the text to be searched in the Find what box.

Step-4 : Click on the More button to get some advanced search options to
help you refine your search.

Step-5 : To find for further occurences, click on Find Next. Press Esc key
to stop searching.

2. Follow these steps to replace text with some alternate text :

Step-1 : Click on the Home tab.

Step-2 : Click on Replace in Editing group.

The Find and Replace dialog box appears.

Step-3 : Type the text to be searched in Find what box.

Step-4 : Type the text to be replaced in the Replace with box.

Step-5 : Click on Replace to replace the current word.

Selecting Replace all option will replace all the occurences of the word
‘Compute’ with ‘Computer’.

Step-6 : Click on More button to get more search options.

Step-7 : Refine your search and select direction of search by selecting the
search options.

3. Follow these steps to insert a hyperlink in a document.

Step-1 : First of all select the text on which you want to insert hyperlink.
Step-2 : Click on the Insert tab on the ribbon.

Step-3 : Click on the Hyperlink available in Links group.

Step-4 : The Insert Hyperlink dialog box appears with several options,
through which you can create a link.

For example, if you click the option Existing File or Web Page, a list
appears.

Step-5 : From the list of available files, click on the desired file to create a
link to that file.

You can also type the name of a website in the Address box to create a link
to that website.

Step-6 : Now click on OK button. It will inset a hyperlink in your
document.

4. Follow these steps to create a drop cap letter :

Step-1 : Click in the paragraph that you want to begin with a drop cap
letter.

Step-2 : Click insert tab.

Step-3 : Click Drop Cap from Text group and select the option from the



list. Observe the effect on your paragraph.

(G) 1. The layout position of the paper for printing is known as orientation.
MS-Word provides two ways to set orientation of a page in a document.
These are-Portrait and Landscape.

2. The blank space around the edges of the page is called page margin. You
can see this space on all the four sides of the page called— top margin,
bottom margin, left margin and right margin. All the text and images are
inserted inside the margin.

3. When we combine the main document with the data source, the process
is called the merging. The final document is called the merged document.

Chapter-4

(A) 1. address 2. Sum function 3. Filtering Data 4. Max function

(B) 1.(a)2.(b)3.(b)4.(b)5.(a)

(C) 1. cell referencing 2. filtering data, filtering 3. functions 4. specific
5. dollar 6. one

(D) 1. Autosum 2. Date & Time 3. Lookup & Reference 4. Math & Trig

(E) 1.(b)2.(a)3.(e)4.(c)5.(d)

(F) 1. Cell referencing means how a cell address behaves in the formulae
when it is copied from one cell to the other. User can find three types of
cell referencing in MS-Excel—

(a) Relative referencing (b) Absolute referencing (c) Mixed referencing
2. Arranging data either in ascending or descending order is known as
sorting. There are three options to sort in MS-Excel-2007.

(a) ascending order (b) descending order (c) sorting on criteria

3. IF-function is a conditional function. Any condition always results in
either True or False. This function returns the first value if the condition
specified evaluates to TRUE and second value if it evaluates to FALSE.
Syntax : = IF (condition, value — if — True, value — if — False)

Example :

=1IF(A1 > 50, 150, 100)

It shows that if the value in a cell Al is greater than 50, return value 150,
otherwise return value 100.

4. Arranging data either in ascending or descending order is known as
sorting. There are three options to sort in MS-Excel-2007.

5. Conditional Formatting feature allows you to format the data in the
worksheet depending on the specified condition.

For example, one can display marks greater than 180 in green colour.

6. Predefined commands that act on a cell or range of cells and perform
some particular operation quickly are known as functions. Excel 2007
provides a variety of functions like Auto Sum, recently used, financial,
logical, text, date and time, lookup and reference, maths and trig, etc.

(G) 1. Follow the given steps to apply conditional formatting.

Step-1 : Create the sheet and select the cells within the range. Here, it is F1
- F7.
Step-2 : Click Home tab on the Ribbon and click Formatting from Styles

group.
QD



Step-3 : Select the required option from the drop down list to specify
condition.

For example, Highlight Cell Rules Greater Than. A dialog box appears.
Step-4 : Type the value to frame the condition and choose the formatting
style you want.

Step-5 : Click OK button. User can see the formatting applied to the cells
that satisfy the condition.

2. Follow the given steps to sort the data—

Step-1 : Create the work sheet and select the cells. For example, A1:E7.
Step-2 : Click the data tab on the Ribbon.

Step-3 : From the sort and filter group, click sort A to Z to sort in
ascending order or sort Z to A to sort in descending order. User's data gets
sorted.

(H) 1. In Relative Referencing the cell reference is a normal cell address like
Al, C3, HS5, etc. In this type, the formulae in the copied cell changes
according to the change in the position of the cell pointer. If the user copy
the formula across rows or down columns, the formula or cell reference
changes automatically.

2. When one part of the cell address is relative and the other is absolute, it
is called the mixed referencing. So either the column or the row number
should have a $ along it.

For example, $C4 is a mixed cell reference with absolute column and
relative row and D$4 is a mixed cell reference with relative column and
absolute row.

3. It is a quick way to find a set of data in a range. A filtered range displays
only the rows that meet the condition you specify for a column.

Chapter-5

(A) 1. Chart or graph 2. Line chart 3. Bar chart 4. Area chart 5. Scatter chart

B) 1.(a) 2. (b) 3. (b) 4. (b)

(C) 1. numeric data 2. Charts 3. bar 4. Pyramid chart 5. design

(D) 1.(d)2.(b)3.(c)4.(a)

(E) LX2.v/3. X4V 5V

(F) 1. The data and text in Excel chart are linked to the data and text in a

worksheet from which the chart is created. So any changes in the
worksheet will automatically update the chart.

2. Follow these steps to change the style of chart :

Step—1 : First double click the chart. It will open Design tab displaying
chart tools.

Step—2 : Click on More button in the Chart styles group.

Step—3 : It will show you a gallery of different styles. choose the style of
your choice by clicking on the desired option.

3. You can easily move and resize chart in MS-Excel 2007.

> To move a chart, point anywhere inside the chart and drag it in the
desired direction.

> You can adjust a chart by dragging the charts frames called handle.
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(H)

> To resize a chart proportionally, drag the corner handle on the chart
diagonally.

4. Deleting data from the related worksheet, automatically deletes data
from connected Excel chart.

5. MS-Excel 2007 can create an appropriate chart for you on its own.
Select the cells that contains the data for which you want to create chart.
Now, press F11 key. MS-Excel automatically creates a chart for you and a
new tab (Chart tab) appears along with the sheet tabs.

6. Follow these steps to change the type of a chart currently on your
worksheet :

Step—1 : Double click the chart. It will open Design tab, displaying the
chart tools.

Step—2 : Click on the Change Chart Type in the Type group. The Change
Chart Type dialog box appears.

Step—3 : Choose the desired chart Type and its subtype.

Step—4 : Now, click on the OK button.

Your chart gets changed according to your choice.

1. You can create a chart of your own choice by following these steps :
Step—1 : Select the cells that contains the data for which you want to create
chart.

Step—2 : Click on the Insert tab on the Ribbon.

Step—3 : Select the type of chart you want from the charts group. Here, we
are selecting column chart type.

Step—4 : Now select the chart subtype from the drop down list.

2. Follow these steps to print a chart in MS-Excel.

Step—1 : Select the chart.

Step—2 : Click on the Office button.

Step—3 : Click on Print option. The Print dialog box appears.

Step—4 : Click on OK button.

3. Follow these steps to modify the style of chart :

Step—1 : First double click the chart. It will open Design tab displaying
chart tools.

Step—2 : Click on More button in the Chart styles group.

Step—3 : It will show you a gallery of different styles. choose the style of
your choice by clicking on the desired option.

4. The data and text in Excel chart are linked to the data and text in a
worksheet from which the chart is created. So any changes in the
worksheet will automatically update the chart.

1. Line chart : A line chart shows trends in data at equal intervals. Line
charts are useful to depict the change in a value over a period of time. A
line chart is a better option when you have many points to plot or when
data trends are important.

2. Pie Chart : A pie chart shows one data series in the form of the
comparative size of things that make up the data series to the sum of items.
3. Column Chart : A column chart shows data changes over a period of
time or illustrates comparisons among items.



Chapter-6

(A)
(B)
(©
(D)

(E)

(F)

1. By using database software 2. Telephone directory 3. MS-Access

4. Memo field

1. (b) 2.(a) 3.(b) 4.(b)

1L.X2.X3. X4V 5V

1. Key field 2. MS-Office 3. intersection 4. Form 5. template 6. table
structure

1. A collection of related information is called a database. In other words,
database is a collection of data organized in a manner that allows easy
access, retrieval and use of that data. Telephone & address books are
examples of paper databases.

2. All object of a database are stored in a single file. These are managed
through the database window. Now, we will discuss the main objects of a
database—

a. Table : It is a part of the database where the actual data is stored. MS-
Access stores the related entries in its row. This row is called a record/each
type of detail in a record is stored in its columns known as fields. A table is
a set of columns and a field.

For example, in a table, the names of all the students of your class can be
stored in one field with a field name as 'Name' and all the fields of Name,
Age Address together form the record of a particular student. Insert doc.
table.

b. Query : One can extract information from a database by using a query.
It is a record or a group of records that fulfill a certain condition. An
example of a Query is to "get the record of the student with Roll No. 10".
You can use a query to view a subset of your data or to answer questions
about your data. Insert Doc. — Understanding Queries.

c¢. Form : A form resembles a fill in the blanks sheet that you fill
completely by hand, such as a job application. Hence a form is a way to
enter data into the database. MS-Access links a form to table and stores the
information that the user put in a form into the table.

d. Report : Just as forms are designed to be onscreen, reports are designed
to be printed with Access. One can design reports quickly, understanding
keeps based on the data.

3. The table structure indicates what kind of table has to be created. A table
structure identifies the name, size and type of various fields.

You can store various types of data in a table. These types vary according
to the fields in a table.

4. A table should have at least one field which has a unique value for each
record. For example : In your school database, your roll number uniquely
identifies you as student. You might have the same name but you never
have the same roll number as your classmate. So, in the school database,
the Roll Number field is the Primary key.

1. Microsoft Access : MS-Access or Microsoft Office Access is a popular
Relational database management system. It is a part of Microsoft Office
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package. MS-Access is widely used by small business firms, within
departments of large organizations, and hobby programmers to create
customized systems for handling the creation and manipulation of data.

2. Table : It is a part of the database where the actual data is stored. MS-
Access stores the related entries in its row. This row is called a record/each
type of detail in a record is stored in its columns known as fields. A table is
a set of columns and a field.

For example, in a table, the names of all the students of your class can be
stored in one field with a field name as 'Name' and all the fields of Name,
Age Address together form the record of a particular student. Insert doc.
table.

3. Form : A form resembles a fill in the blanks sheet that you fill
completely by hand, such as a job application. Hence a form is a way to
enter data into the database. MS-Access links a form to table and stores the
information that the user put in a form into the table.

4. Text Field : It contains letters, numbers and symbols. The numbers in a
text field are considered as text and cannot be used for calculation. The
length of the text field varies. Sometimes it can contain a combination of
upto 255 characters. For example— Rajesh, Vital2, A228899T, etc.

5. Numeric Field : It contains numbers. A numeric field does not accept
letters or other symbols except numbers. For example— 56, 2008, 1999,
11247, etc.

6. Query : One can extract information from a database by using a query.
It is a record or a group of records that fulfill a certain condition. An
example of a Query is to "get the record of the student with Roll No. 10".
You can use a query to view a subset of your data or to answer questions
about your data. Insert Doc. — Understanding Queries.

7. Memo Field : It contains long text with all kinds of data. For example—
Hello! My name is Mayank, I am 23 years old, I live in New Delhi, etc.

8. Report : Just as forms are designed to be onscreen, reports are designed
to be printed with Access. One can design reports quickly, understanding
keeps based on the data.

9. RDBMS : A collection of data items organized as a set of formally
described tables is called a relational database. Data can be accessed or
reassembled from these tables in different ways without a need to
reorganize the database tables. The concept of relational database was
given by E.F. Codd at IBM in 1970.

In addition to being relatively easy to create and access, a relational
database has the important advantage of being easy to extend. After the
original database creation, a new data category can be added without
modifying all existing applications.

1. Follow the given steps to start MS-Access—

Step—1 : First click the Start button.

Step—2 : Click the All programs option.

Step—-3 : Click Microsoft Office.



Step—4 : Click Microsoft Office Access 2007.
The MS-Access-2007 screen that appears is given below. Now, you can
create a new database, or open an existing one.
2. Follow the given steps to create a blank database—
Step—1 : On the Getting started with Microsoft Office Access page, click
Blank Database.
Step—2 : In the Blank Database pane, type the name of the database in the
File Name box.
Step—3 : Click Create button.
It will make Access create and open a blank database. By default, an empty
table is opened (Table—1) in which user can enter data.
3. First create the table's structure in Design view.
Follow the given steps to create a table using design view :
Step—1 : Click Create tab on the Ribbon.
Step—2 : Click Table Design from the Tables group. The new table's design
view opens up.
Following these steps will create the table structure—
Step—3 : Type name of a field in Field Name column and press Tab key to
move the Data Type column.
Step—4 : An arrow appears for a drop down list in the Data Type column.
Click the arrow and select a Data Type from the list.
Step—5 : Press Tab key to move to the Description column and type a
description of the field. The description of the field is optional.
Step—6 : Save the table after adding all your fields by clicking Save button
on the Quick Access toolbar.
Step—7 : Type the name and click OK button.
4. Do yourself
5. Follow the given steps to create a table using datasheet view—
Step—1 : Click Create tab on the Ribbon.
Step—2 : Click Table from Tables group. Access creates a table and selects
Add New Field column by default.
Step—3 : Click in the column and type the data in it and press Tab key to
add a new field to the table.
Step—4 : Now save the table by clicking the Save button in the Quick
Access toolbar in the title bar.
Step—5 : Give a name to the table in the Save As dialog box.
Step—6 : Click the OK button.
6. Do yourself

Chapter-7

(A) 1.(b)2.(a)3.(b)4.(a)5.(a)

(B) 1. Beginners All-purpose Symbolic Instruction Code 2. By activating
menu
3. The QBASIC window has the following components :
Menu Bar
Name of the Current Program
Status Bar
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(G)
(H)
@
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Status of Caps Lock, and Num Lock

Current Line Number

Current Column Number

1. Beginners All-purpose Symbolic Instruction Code 2. numeric,
alphabetic 3. arithmetic, relational, logical 4. numeric 5. NOT, AND, OR

1. (b) 2.(c) 3.3

1. String Variable 2. String Variable 3. String Variable 4. Numeric Variable
5. String Variable 6. Numeric Variable 7. Numeric Variable 8. String
Variable

1. Invalid, Because it does not have digits or $ sign.

2. Invalid, Because it has not started with a letter.

3. Invalid, because it is starting with a digit.

4. Valid 5. Valid

Do yourself

I.LETT4=452. LET X=X+503.LETM=Y 2/34. LETC=2A+ 3B
Do yourself

Do yourself

1. The following hierarchical order is used while evaluating the above
expression.

N First
* and / second
+ and —Third

2. Relational operators are used to compare two values. They are compared
with the help of the following operators.
Equal
Less than
Greater than
Less than or equal to
Greater than or equal to

<> Not equal to
3. Sometimes it become necessary to change the order of execution of the
statements, or to repeat a particular series of statements until certain
specified conditions are met.
Such situations require logical decision-making. This facility is provided
by means of control statements. The control statements available in BASIC
are: IF... THEN, FOR... NEXT, and GOTO. We will take up only the
IF...THEN statements here.
4. The general format of the statement is as follows :
IF < CONDITION > THEN < STATEMENT > ELSE < STATEMENT>
5. Using the Else statement, you can have the program perform a different
action if the statement is false.
The general format of the statement is as follows :
IF < CONDITION > THEN < STATEMENT > ELSE < STATEMENT>
The condition which is part of the IF... THEN statement compares both
numeric and string values.

AV A
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If the condition is true, the statement given next to THEN will be executed.
If it is false, the statement given next to ELSE will be executed.
Example

IF X =0 THEN PRINT A ELSE PRINT B
In the above statement, if the value of X is zero, then A will be printed.
Otherwise the value of B will be printed. After printing either A or B,
control is transferred to the next statement.

Chapter-8

(A) 1. Elk Cloner 2. Brain 3. Macro viruses 4. Norton Antivirus, QuickHeal
Antivirus

(B) 1.(a) 2.(a) 3.(a)

(C) 1. Macro 2. endless 3. Internet 4. scripting 5. system

D) 1.LX2/3 V4 X5V

(E) 1. Following are some harms caused by computer viruses :

> Virus fills up the disk's space of a computer by copying itself endless
times.

> They infect or damage executable programs or files, such as word
processors or operating system programs.

> They infect disks by attaching themselves to special programs called
boot records in hard disk. These are the programs computer uses to start
up.

> They steal your account and password and send them to other people
through Internet.

2. Computer viruses are transmitted from one computer to another when
you copy infected data from an external source. Some of the most common
ways in which your computer gets virus are :

> Through an infected floppy disk, CD or pen drive.

> Visiting malicious website and downloading infected files.

> Through infected e-mail attachments.

> Downloading free games, toolbars, media players & other system
utilities.

3. To protect your computer from a virus infection, follow these basic rules
listed below :

> Restrict users access to your system, working either offline or online.
Only allow genuine users to use the system and that too under supervision.
> Do not use a CD or a pen drive received form another person unless you
are certain that the disk does not contain a virus.

> Keep programs and data on separate disks. If possible.

Be on the lookout for unexplained changes in your system.

> Do not download programs or other material from non-reputed sources
on the Internet.

> Do not view or download the files you receive in your e-mail, if sent
from an unknown person. Open only those files sent by the people you
trust.

> [t is necessary to install an anti virus program on your computer.
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4. Antivirus Softwares are application programs designed to detect and
remove viruses from computer systems. Antivirus programs are memory
residents. Whenever the computer system booted the antivirus program
starts. It checks for viruses in all the files of the computer system. If a virus
is detected, then the program will try to remove the antivirus.

1. History of Computer Viruses : Elk Cloner was the first virus that
attached itself to the apply DOS 3.3 Operating System. It was created by
Rich Skrenta in the year 1982.

Brain was the first PC virus created by two brothers Basit and A.F. Alvi in
the year 1986. It was a boot sector virus. They created this virus to prevent
pirated copies of software they had written.

Since the mid 1990s, macro viruses have become common. Macro viruses
are written in the scripting languages, for Microsoft programs such as MS-
word and MS-Excel.

2. Program Viruses : Program viruses infect program files, which have
extensions such as . COM,. EXE,. SYS, .OVL or .SCR. Program files are
easy targets for computer viruses because they are widely used and have
relatively simple formats to which viruses can attach themselves.
Examples of such viruses are Trojan, Acid rain, Cargy. A, etc.

3. Macro Viruses : Macro viruses infect data files. For example-Microsoft
word documents and template files are susceptible to macro virus attacks.
They spread rapidly as infected documents are shared on network or
downloaded from Internet sites.

1. To find viruses on your computer, do the following :

Step—1 : Double click the Quick Heal Antivirus icon from the system tray
on the taskbar.

The Quick Heal Antivirus window appears.

Step—2 : Click the scan option. The corresponding window will appear.
Step—3 : Select a scan task from the list and click on the scan option.

The Scan Progress dialog box appears. It reports the status of the scan.

2. Whenever you attach any external device like a pen drive or a CD-ROM
to your computers, the antivirus software immediately asks you to scan it.
Just click on Full scan option.

The process of scanning starts. It the device contains virus, the antivirus
displays an alert message and then deletes it.

3. Virus definitions are the database of viruses that Quick Heal Antivirus
scans for. This database needs to be updated regularly so that Quick Heal
Antivirus can detect newly created viruses.

To update your antivirus, connect to the Internet and follow these steps :
Step—1 : In the Quick Heal Antivirus main window, click on Update Now.
Step—2 : Close the Quick Heal Antivirus window when the update process
completes.
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Chapter-1

(A) 1.(a)2.(b)3.(a) 4. (b)

(B) 1. Server 2. Client 3. Bus, Star, Ring 4. Telephone Network 5. Internet

(C) 1. Networking 2. LAN 3. Computer 4. WLAN 5. print 6. Topology

D) 1L.vVv2vy3 X4/ 5K

(E) 1. A network connects computers by means of cabling system, specialized
software and devices that manage the data traffic. A network enables users
to share files and resources, such as printers as well as send messages
electronically (e-mail) to each other.

2. A local area network (LAN) is a group of networked computers that
are relatively close together, such as in the same building.

A metropolitan area network (MAN) is a high-speed network that
connects local area networks in a metropolitan area such as a city or town
and handles the bulk of communications activity across that region.

A wide area network (WAN) is a network that is spread out over a
relatively large geographical area, such as a city, country, or even the world.

3. A communication device is any type of hardware capable of
transmitting data, instructions, and information between a sending device
and a receiving device. Communication devices could be of different types
such as HUB, Switch, Modem, Router, etc. When two networks are
connected, all the computers on both the networks can exchange
information.

4. In this network, computers can be directly connected to each other
and file and other information can be accessed directly by connecting to
another computer. However, for this to take place, it is necessary that the
computer from which the data need to be accessed should be turned ON.
For example, if Computer 2 requires the X-file from Computer 1, it cannot
do so if Computer 1 is turned OFF.

Peer-to-Peer network is a simple, inexpensive network that typically
connects fewer than 10 computers. Each computer, called a peer, has equal
responsibilities and capabilities, sharing hardware (such as a printer), data, or
information with other computers on the peer-to-peer network.

Chapter-2
(A) 1.(b)2.(b)3.(a)4.(a)5.(b)
(B) 1.0and 12.decimal, binary, octal and hexadecimal 3.104.0and 1 5.8
(C) 1.pulse2.103.binary 4. octal 5. hexadecimal
D) 1L.v2.vy3.X4V5X
(E) 1.(a)10101101 (b)0000000101010111
(c)00101101 (d)00111110
2.(a)107(b)227(c) 173 (d) 347
3.(a)3422(b)36226 (c)103316(d) 131052
4.(a)19(b)55(c)73(d)336
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5.(a)3(b)27(c)57
6.(a) 110010011100 (b) 11011100100
(c)10011100101
7.(a)9978 (b) 635
(c)52274  (d) 2730
8.(a)8AE  (b) 136
(c)230 (d) E7
1. (a) 1011100 (b) 111110 (c) 11110

(d) 101101 (e) 1101000 (f) 1010001
2. (a) -10 (b) 1 (c) 0

(d) 101 (e) 110010 (f) 1001001
1. Computer is an electronic device and it accepts and stores data in the form of
digits, numbers, letters, special character, etc. But while processing, the data is
converted into its own language i.e. Machine Language, which is in the form of
Binary Digitsi.e.0Oand 1.
These binary digits are used to represent the absence and presence of an
electronic pulse. For example, 0 represents the absence (OFF) of electronic
pulse and 1 represents the presence (ON) of electronic pulse.
As computer works on binary number so, the number system is used for
representing these electronic pulses.
Generally a computer deals with the following number system :
> Decimal number system.
> Binary number system.
> QOctal number system.
> Hexadecimal number system.
2. The arithmetic operations-addition, subtraction, multiplication and
division, performed on the binary numbers is called binary arithmetic. In
computer system, the basic arithmetic operation performed on the binary
number is Binary Addition and Binary Subtraction.
3. The Decimal number system is the base 10 number system. It includes all the
digits from 0t0 9 (0, 1,2, 3,4, 5,6, 7, 8 and 9). Decimal number system is the
most commonly used number system. Decimal Numbers do not necessarily
contain a decimal point. For example 5.63, 56.3 and 563 are all decimal
numbers.
Binary number system is a system of numbers to base 2, using the combination
of the digits 1 and 0. Codes based on binary numbers are used to represent
instructions and data in all modern digital computers. The values of binary
digits being stored or transmitted as Open/Closed switches
magnetize/unmagnetize disk and high/low voltages in circuits.
4. The Octal Number System is a system with less symbols to use than other
conventional number system. Octal is the base 8§ number system that uses the
digits from 0 to 7 arranges in the series of columns to represent all numerical
quantities. Each column and place value has weighted value of 1, 8, 64, 512



and so on ranging from right to left.

Hexadecimal is a number system with a base of 16, usually used in computing.
There are 16 symbols or digits in Hexadecimal number system. The first 10
digits are like decimal number system - 0, 1, 2, 3,4, 5, 6, 7, 8, and 9 and the
remaining six digits are the symbols A, B, C, D, E, and F, representing decimal
values 10, 11, 12, 13, 14, and 15, respectively. Each place in a number
increases in value by a power of 16 going from right to left.

5.Adding the binary numbers involves the following steps:

1. Start adding by adding the bits in unit column (the rightmost column). Use
the rules of binary addition.

2. Theresult of adding bits of a column is a sum with or without a carry.

3. Write the sum in the result of that column.

4. If carry is present, the carry is carried-over to the addition of the next left
column.

5. Repeat steps 2 to 4 for each column i.e. the tens column, hundreds column
and so on.

The steps for performing subtraction of binary numbers are as follow:

1. Start subtraction by subtracting the bits in the lower row from the upper row,
in the Unit column.

2. Use the binary subtraction rule. If the bit in the upper row is less than lower
row, borrow 1 from the upper row of the next column (on the left side). The
result of subtracting two bits is the difference.

3. Write the difference in the result of that column.

4.Repeat steps 2 and 3 for each column, i.e., the tens column, hundreds column
andsoon.

Chapter-3
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1. (b) 2.(b) 3.0b)

1. Table, query, form, report

2. Creating a Blank Database, Using a Template, Downloading a template
from Microsoft Office Online

3. Add a new record/row, Add a new field/column, Update a record, Delete a
row/column

4. To delete a particular row/column, select the entire record or entire column
by clicking on the row header or column header and press the delete key or
right-click the mouse and select Delete Record. Click Yes to confirm.

1. processed 2. tables 3. Value 4. datasheet view 5. primary
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1. Databases are very useful in maintaining data. They provide many
advantages to users. They help in easy retrieval of data and reduction of data
redundancy. They are helpful in reduction of data inconsistency. They make
sharing of data easy. They make the manipulation of data easy and also help in
the security of data.

2. A data sheet view shows the data in the database. It allows you to enter and
edit the data, but you cannot change the format of the database.
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Design view allows you to create or change the table, form or any other
database object.

3. A table should have at least one field which has a unique value for each
record. For example : In your school database, your roll number uniquely
identifies you as student. You might have the same name but you never have
the same roll number as your classmate. So, in the school database, the Roll
Number field is the Primary key.

A Primary key does not allow Null Values and must always have a unique
value.

A primary key is used to relate a table to foreign keys in other tables.

4. Text Field : It contains letters, numbers and symbols. The numbers in a
text field are considered as text and cannot be used for calculation. The
length of the text field varies. Sometimes it can contain a combination of
upto 255 characters. For example— Rajesh, Vital2, A228899T, etc.
Numeric Field : It contains numbers. A numeric field does not accept
letters or other symbols except numbers. For example— 56, 2008, 1999,
11247, etc.

5. Some advantages of database are:

Easy retrieval of data

Reduction of data redundancy

Reduction of data inconsistency

Easy sharing of data

Easy manipulation of data

Data security

You can perform various kinds of operations on a database like creation,
deletion, modification and updation.

6. Firstcreate the table's structure in Design view.

Follow the given steps to create a table using design view :

Step—1 : Click Create tab on the Ribbon.

Step—2 : Click Table Design from the Tables group. The new table's design
view opens up.

Following these steps will create the table structure—

Step—3 : Type name of a field in Field Name column and press Tab key to
move the Data Type column.

Step—4 : An arrow appears for a drop down list in the Data Type column.
Click the arrow and select a Data Type from the list.

Step—5 : Press Tab key to move to the Description column and type a
description of the field. The description of the field is optional.

Step—6 : Save the table after adding all your fields by clicking Save button
on the Quick Access toolbar.

Step—7 : Type the name and click OK button.

1. Database : A collection of related tables with data is called a database.
The data remains in an organized order in a database. A simple example of a
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database is the attendance register for your class, maintained by your
teacher.

2. RDBMS : A relational database is a collection of data items organized as
a set of formally described tables. Data can be accessed or reassembled
from these tables in different ways without a need to reorganize the
database tables. The concept of relational database was given by E.F. Codd
at IBM in 1970.

3. Table : A Table is a part of the database where the actual data is stored. MS
Access stores the related entries in its row. This row is called a record. Each
type of detail inarecord is stored in its columns known as fields.

4. Query : A query is used to extract information from a database. It is a record
or a group of records that fulfill a certain condition. An example of a query is to
"get the record of the student with Roll No. 32".

5. Report : Just as forms are designed to be onscreen, reports are designed to
be printed. With Access, one can design reports quickly, based on the data.

6. Template : A template is a ready to use database. It contains tables, queries,
forms and reports needed for performing a specific task.

Several templates are displayed on the Getting started with Microsoft Office
Access page. You can download more from the Microsoft Office website.

7. Table Structure : The table structure indicates what kind of table has to
be created. A table structure identifies the name, size and type of various
fields.

You can store various types of data in a table. These types vary according to
the fields in a table.

8. Primary Key : A table should have at least one field which has a unique
value for each record. For example : In your school database, your roll
number uniquely identifies you as student. You might have the same name
but you never have the same roll number as your classmate. So, in the
school database, the Roll Number field is the Primary key.

9. Relationship : After you have created multiple tables in your MS Access
database, you need a way to tell Access how to bring that information
together again. The first step in this process is to define relationships
between the tables. After creating relationships, you can create queries,
forms and reports to display information from several tables at once.

A relationship works by matching data in key fields; usually a field with the
same name in both tables.

1. Follow the given steps to create a database using a template :

Step—1 : Click the Local Templates from the Template categories on the left
pane.

Step—2 : From the middle pane, choose the database you want, for example,
Contacts.

Step—3 : Specify a name for the database in the File Name box.

Step—4 : Click on the create button.

Access creates and opens the database for you. By default a form is opened



where you can enter data.
2. Follow the given steps to create a table using datasheet view—
Step—1 : Click Create tab on the Ribbon.
Step—2 : Click Table from Tables group. Access creates a table and selects
Add New Field column by default.
Step—3 : Click in the column and type the data in it and press Tab key to add
a new field to the table.
Step—4 : Now save the table by clicking the Save button in the Quick
Access toolbar in the title bar.
Step—5 : Give a name to the table in the Save As dialog box.
Step—6 : Click the OK button.
3. To create a relationship, follow the given steps:
Step—1 : Create both the tables and open one of them in Datasheet view and
click Datasheet tab on the ribbon.
Step-2 : Click Relationships from Relationships group.
The Show Table dialog box appears.
Step-3 : Select the tables and then click the Add button. Select another table to
link, Click Add button.
Step-4 : Click Close button.
Step-5 : Drag the primary key of the parent table (here, Activity table), and
drop itinto the same field in the child table (here, Marks table).
The Edit Relationships dialog box appears.
Step-6 : Click Create button.
You see the relationship created. Save your work.
Chapter-4
(A) 1.(b) 2.(b) 3.(a)
(B) 1.Aformis very good to use when you have numerous fields in a table
2. It is used to specify the condition on the basis of which the records will be
filtered
3.Table 4. Show
(C) 1. form 2. information 3. Navigation 4. Report View, Print Preview, Layout
View, Design View 5. Autoformat
(D) 1.(d)2.(a)3.(e)4.(c)5.(F)6.(b)
(E) 1.There are three views in which a form is displayed: Form View, Layout View
and Design View.
2. To switch views, click View from the Design tab on the Ribbon .
> Form View is used to enter or edit data .
> Design View is used to adjust the design of your form .
> Layout View is used to change the format of your form.
3. To create a form, select the table for which you want to create the form and
follow the given steps:
Step-1 : Click the Create tab on the Ribbon.
Step-2 : Click Form in the Forms group. Access creates a form and places all
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fields of the selected table on the form.

Use the Navigation bar to move through the records on the form.

4. Query : A query is used to extract information from a database. It is a record
or a group of records that fulfill a certain condition. An example of a query is to
"get the record of the student with Roll No. 32".

Forms : A form resembles a fill-in-the-blanks sheet that you would complete
by hand, such as a job application. Hence, we can call a form, simply a way to
enter data into the database.

Report : Just as forms are designed to be onscreen, reports are designed to be
printed. With Access, one can design reports quickly, based on the data.

5. The Query window is divided into two panes. The top pane displays the
tables selected for the query. The bottom pane displays a design grid where you
can add fields to the query and also specify the criteria.

Letus understand the Design grid.

Field row displays the fields from the selected table.

Table row displays the name of the table.

Sort row is used to filter the data in ascending or descending order.
Show row displays a check mark which indicates that this field will be

visible when the query is run.

Criteria row is used to specify the condition on the basis of which the
records will be filtered.

or row isused to specify multiple criteria.

6. User can add a new table to an existing database by using the tools in the
tables group on the Create tab—

1. Using Datasheet view and 2. Using Design view

Creating A Table Using Datasheet View

(F)

Using datasheet view, users can enter data in the table directly. Follow the
given steps to create a table using datasheet view—

Step—1 : Click Create tab on the Ribbon.

Step—2 : Click Table from Tables group. Access creates a table and selects
Add New Field column by default.

Step—3 : Click in the column and type the data in it and press Tab key to add
a new field to the table.

Step—4 : Now save the table by clicking the Save button in the Quick
Access toolbar in the title bar.

Step—5 : Give a name to the table in the Save As dialog box.

Step—6 : Click the OK button.

1. To create a query, follow the given steps:

Step-1 : Click Create tab on the Ribbon.

Step-2 : Click Query Design in the Other group.

The Show Table dialog box appears.

Step-3 : Choose the table on which you want to generate your query. (Here, it is
the Activity table.)
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Step-4 : Click Add. The selected table is added in the query window.

Step-5 : Click Close.

2. To create a form, select the table for which you want to create the form and
follow the given steps:

Step-1 : Click the Create tab on the Ribbon.

Step-2 : Click Form in the Forms group. Access creates a form and places all
fields of the selected table on the form.

Use the Navigation bar to move through the records on the form.

3. To create a report, select the table or query on which you want to create your
report and follow the given steps:

Step-1 : Click Create tab on the Ribbon.

Step-2 : Click Report in the Reports group.

Access creates a report and places all fields of the selected table on the report.

Chapter-5
(A) 1.(a) 2.(b) 3.(b) 4.(a) 5.(b)
(B) 1.Attributes offer many options for the text contained by tags
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2. Title tag is used to give a title to the HTML document

3. empty and non-empty 4. Extensible Markup Language

1. computer networks 2. servers 3. web pages 4. Ted Nelson, 1960 5. Tim
Berners Lee

1.(b) 2.(¢) 3.(a 4 5() 6.(d

1. The individual computers are connected to some powerful computers called
servers. These servers store files and information in the form of websites.
These files (websites) can be accessed by different users anywhere from the
world, using Internet connection.

2. Four symbols are generally reserved in HTML: Greater than (>), Less than
(<), Straight double quotes (" ") and Ampersand (&).

3. Servers store files and information in the form of websites. These files
(websites) can be accessed by different users anywhere from the world, using
Internet connection. Websites contain different pages called web pages.

4. HTML tag determines the way, the browser would display the text. The tags
are always enclosed within a pair of angular brackets, i.e, < and >. The text is
written in the tags. For example: <title>, <head>.

5. Non-empty tags require an opening (ON) tags and closing (OFF) tags.

ON tags are written within the angular brackets and OFF tags are also written
within the angular brackets, but using a slash (/) before the command.

Empty tags are those that do not require a closing tag. These tags are also
written within angular brackets. For example: <HR>, <BR>.

6. HTML stands for HyperText Markup Language. The word Hypertext
was first introduced by Ted Nelson in 1960s.

Markup language is a technique to write documents, describing the general
structure of the contents inside the documents and not its actual appearance on
the page or on the screen. HTML allows the user to link several related
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information already stored in the computer or server that can be accessed from
anywhere around the world.

Features of HTML

HTML is a markup language and not a conventional programming language.
Some of the features of HTML are:

> HTML documents are simple text files. Web browsers act as HTML
formatters.

> There is no need of compiling as in the case of other programming
languages.

> [tisnotacase sensitive language.

>  HTML documents can be viewed on any type of computer platform.

7. Aweb browser is used to display and view the HTML documents. Examples:
Internet Explorer, Mozilla Firefox, Opera, Safari, etc.

(F) 1. Features of HTML : HTML is a markup language and not a
conventional programming language. Some of the features of HTML are:

> HTML documents are simple text files. Web browsers act as HTML
formatters.

> There is no need of compiling as in the case of other programming
languages.

> [tisnotacase sensitive language.

>  HTML documents can be viewed on any type of computer platform.
2.Tools Required to Create a Web Page

You require three tools to create and view an HTML document. These are:

1. Text editor : Text editor are programs that are used to create or compose
HTML documents. Examples: Notepad, WordPad, etc.

2. A web browser : A web browser is used to display and view the HTML
documents. Examples: Internet Explorer, Mozilla Firefox, Opera, Safari, etc.
3. A web server (optional) : These are required when you want to store the
HTML document.

3. Structure of An HTML Document

AITHTML files should include at least the following four tags:

1. <HTML> tag - This tag indicates that the document has been
written in HTML.

</HTML> tag — Itindicates the end of the HTML document.

2. <TITLE>tag — This tag is used to give a title to the HTML
document.

</TITLE>tag — Itisusedtoendtitle.

3. <HEAD>tag — Thisisused to give the heading of the web page.

</HEAD> tag — Itisusedtoend the head.

4, <BODY>tag — This contains the body of the web page. It is the area
where most of the work is done.

</BODY>tag — Itisusedtoend the body.

The contents between <BODY> and </BODY> tags are displayed in the



browser.

Chapter-6
(A) 1.Usedtoinsertanimage?2. Using <B>tag 3. .html4. <UL>tag
(B) 1.(a) 2.(a) 3.(b) 4.(a)

(C) 1.webpage?2.Headers 3. <P>4. height 5. marquee
(D) 1.(c)2.()3.(e)4.(a)5.(b)6.(d)

(E)
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1. Tables are used to store the data in rows and columns. In HTML, Tables are
created with <TABLE> tag. To add data in each row <TD>tag isused.
2.<U>tagis used to underline the text.

3. Headers are like the chapter headings of a book. You can use six different
headers in your web page. But you may not use more than three at a time.
Header tag is written as <Hn> and </Hn> where n is a number from 1 to 6. For
example, <HI1>.

4. An ordered list is a numbered list. It starts with the <OL> tag. Each list item
starts with <LI>tag.

An unordered list is a bulleted list. It starts with <UL> tag. Each list item starts
with <LI>tag.

5. Background color sets the whole background of your web page in your
desired colour.

To set background colour, type <BODY BGCOLOR = "Colour name or
code">.

6. Font color is used to change the colour of the text. You can even change the
colour of individual character.

To change the font colour, do the following:

> Type <FONT COLOR ="Colour name">

> Type the text.

> Type </FONT>

7. In HTML, the <A> tag is used to define hyperlink. This tag is called the
anchor tag. The HREF attribute is used to set the location or URL of the
destination page or site. The text between the opening and closing anchor tag
becomes the hypertext or link text.

For Example:

<AHREF="D:\Koala.JPG"> Click here </A>.

1. Adding Headers : Headers are like the chapter headings of a book. You can
use six different headers in your web page. But you may not use more than
three at a time. Header tag is written as <Hn> and </Hn> where n is a number
from 1 to 6. For example, <H1>.

To add headers in your web page, do the following:

> Type <Hn>after the <BODY>tag. For example <H1>.

> Type the contents of the header. For example, "Welcome to Nature".

> Type </Hn>. Forexample, </H1>.

2.Adding Paragraphs : In HTML, to add paragraphs, <P>tag is used.

To add a paragraph in your web page, do the following:

&
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> Type<P>

> Type the contents of the paragraph.

> Type</P>

3.Adding Line Breaks : In HTML, to begin anew line, <BR>tag is used.

To add line breaks, Type <BR>where you want the line break to occur.

For example: Type <BR> at the end of the line. "Welcome to the World of
Nature.'

4. Adding Colour To The Lines : Normally, an <HR> tag is used to display a
grey coloured line. You can change the colour by adding a color attribute and
specifying the colour you want.

To add colour to the horizontal rules, type <HR color =name of colour>.

You will see two lines displayed, one in Green and the second one in Blue.

5. Comments are very useful while writing programs. Comments are like
notes. You can add comments in your web page. Comments are not visible in
the browser.

To add comments, do the following:

> Type<!

> Typethe comments.

> Type>

1. To change the font, do the following:

> Type <FONT FACE ="fontname">

Forexample: <FONT FACE="COMIC SANS MS">

> Type the text.

> Type<FONT>

2.Fontsize isused to change the height of the character.

To change the font size, do the following:

> Type<FONT SIZE ="n">, where n is the value of the font.

> Type the text.

> Type</FONT>

3. To change the font colour, do the following:

> Type<FONT COLOR ="Colour name">

> Type the text.

> Type</FONT>

For example: Type <P> <FONT COLOR = "MAGENTA"> Your text
</FONT>.

4.Toadd atable in your web page, do the following:

Type <TABLE>

Type <TR>

Type <TD> ,type the text.

Type </TD>.

Repeat step-3 and step-4 to add more columns.

Type </TR>

Repeat Step-2 to Step-5 to add more rows.
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Type </TABLE>.

To add hyperlinks, do the following.

Type <AHREF ="location">

Type the link text.

Type </A>

For Example:

<AHREF ="D:\Koala.JPG"> Click here </A>.
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(A)

(B)
©
(D)

(F)

1. Net 2. Inthe early 1990s 3. Web page 4. There are thirteen types of Web sites
5. Universal Resource Locator 6. E-greetings are used to send greetings to
anyone with an e-mail address.
1.(b)2.(a)3.(b)4.(b)5.(a)
1. Internet 2. Informational 3. Home Page 4. Internet Explorer 5. chat
1. Internet Explorer : This Web browser is the most widely used by people
around the world. It was developed by Microsoft in 1995 as a supportive
package to Microsoft Windows operating system.
2. Chatting : You can instantly communicate with people around the world by
typing back and forth. This is called chatting. And it is one of the most popular
features of the Internet.
3. GTalk : Google Talk is Google's instant communications service. Like
Gmail, Google's free webmail service, Google Talk uses Google's innovative
technologies to help people communicate more effectively and efficiently.
This means Google Talk is fast, intuitive and fun to use.
4. URL : URL stands for Uniform Resource Locator, the address that defines
the route to a file on the Web. URLSs are typed into the browser to access Web
pages. For example,

http://www.google.com
retrieves the home page at google Web site. The http:// is the Web protocol, and
www.google.com is the domain name.
5. Facebook : Facebook is also the most popular social networking site on the
Web, with over 100 million users worldwide. Users can add friends and send
them messages, and update their personal profiles to notify friends about
themselves. Facebook started in 2004 as a tool for connecting students at
Harvard University, but it soon expanded to other universities and then to high
school students.
6. Instagram : Instagram is an online mobile photo-sharing, video-sharing,
and social networking service. It was created by Kevin Systrom and Mike
Krieger. It was launched in October, 2010 as a free mobile app. It enables its
users to take pictures and videos, and share them. It was acquired by facebook
inApril,2012.
1. The Internet, also called the Net, is a worldwide collection of networks that
links millions of businesses, government agencies, educational institutions,
and individuals. Each of the networks on the Internet provides resources that
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add to the abundance of goods, services, and information accessible via the
Internet.

2. Web page is an electronic document on the World Wide Web. A vast amount
of information is provided by these Web pages. The information may include
graphics, sound or even movies. Usually a Web page contains links to other
Web pages as well.

Web site is a collection of Web pages. Most Web sites have a home page as their
starting point, which frequently functions as a table of contents for the site.
Users need a Web browser and an Internet connection to access to a Web site.
3.RDBMS stands for Relational Database Management System.

4. It is the first page retrieved when accessing a Web site. It serves as a table of
contents to the rest of the pages on the site or to other Web sites. For example, a
company's welcome page typically includes the company's logo, a brief
description and links to the additional documents available at that site.

5. Web pages contain highlighted text or images, called hyperlinks, that
connect to other pages on the Web. Hyperlinks allow you to easily move
through a vast amount of information by jumping from one Web page to
another. You can select a hyperlink to jump to a Web page located on the same
computer or on a computer across the city, country or world. You can easily
identify text hyperlink in a Web page because they appear underlined and in
color.

1. Portal : A portal is a Web site that offers a variety of Internet services from a
single, convenient location. Portal includes the links of breaking news,
weather forecasts, stock quotes, free e-rnail service, sports scores, and a
subject guide to information available on the Web. Popular portals include
Rediff, Yahoo!, AltaVista, AOL, Dogpile, iGoogle, Excite, GO.com, MSN,
LookSmart, Lycos, MSN, etc.

2.Search Engine : A software program which helps in finding Web sites, Web
pages, and Internet files is called a search engine. Search engines are
particularly helpful in locating Web pages on certain topics or in locating
specific pages for which you do not know the exact URL. To find a page or
pages, you enter a word or phrase, called search text or keywords, in the search
engine's text box.

3. E-commerce : Electronic commerce (e-commerce), sometimes called e-
business, is a financial business transaction that occurs over an electronic
network. Anyone with a computer connected with Internet and a means to pay
(credit card, etc.) for purchased goods or services can participate in e-
commerce. Two popular types of e-commerce are shopping and trading stocks.
4. E-Mail (Electronic Mail) : The electronic mail enables us to exchange
messages with people around the world, including friends, family members,
colleagues, customers and even people you meet on the Internet. E-mail is
quite fast, easy and inexpensive. Unlike postal mail messages which can take
days to be delivered and require postage, e-mail messages are usually



delivered within minutes and you do not pay an extra charge to send them.

5. Social Networking : It is a service on the Internet that enables you to
connect with people who share similar personal or professional interests. On
most social networking sites, the members are connected to each other as
friends, friends of friends, and so on.

Chapter-8
(A) 1.yahoomail 2. yahoo mail 3. hotmail.com
(B) 1.(a) 2.(b) 3.(b) 4.(b)

(C) 1.e-mail 2. Home Page 3. login name 4. inbox 5. signout

D) 1.Vv2.v/3 V45X

(E) 1. To open an account in Ymail, connect your computer to Internet and open
Internet Explorer or any other browser available on your computer.
Now, type www.ymail.com in the address bar. It will open the Home Page
of Ymail.
Follow the steps to create an account on Ymail.
Step 1 : Click on the Create New Account button on the Home Page.
This will open following Internet Explorer Window to the "Create An
Account" page.
Step 2 : Enter your name, surname, gender and birth particulars.
Step 3 : After choosing the login name, enter the desired password in the
box provided. It will also tell you how safe your password is. Choose a
strong password.
Step 4 : Type the optional recovery number. But it is an optional step. It is
not necessary to provide it.
Step 5 : Now, click on the "Create My Account” button.
You will see another screen showing your account details.
2. Follow these steps to send an e-mail using your yahoomail id:
Step-1 : Open Internet Explorer, type www.ymail.com in the address bar
and press Enter. You will see the yahoomail login page.
Step 2 : Enter your login name and password and click on the Sign In
button. This will take you to your yahoomail inbox.
Step 3 : Click on the New E-mail message on the left of the page. This will
take you to the Compose Mail window.
Step 4 : Type the e-mail id of the person you are sending a mail to and the
subject of your message in the To : and Subject : boxes. Then types your
actual message.
Step 5 : When you have finished typing the message, click on the "Send"
button below the message area.
3. Log in to your yahoomail account. This will take you to your yahoomail
inbox. You will get this window every time you will login to your account.
The Inbox shows you a list of messages you have received. The list shows
who sent the messages, what the message is about, and when it was
received.
Follow these steps to read messages in your Inbox.



Step-1 : Click on the message you want to read.

It will open the corresponding e-mail just below the list of received e-mails
as shown below.

4. Follow these steps to create an e-mail account in Gmail :

Step-1 : Open the www.gmail.com website by using Internet Explorer
Step-2 : Click on the ‘Create an account' on the bottom of the page.

It will open the gmail registration form.

Step-3 : Fill in the information— like name, ID, password, alternate e-mail
address, etc.

Click on the ‘Next Step' button.

Step-4 : On the Next screen click on ‘Go to My Inbox' button.

Your account in Gmail is created.

(F) 1. E-mail : E-mail is an electronic version of sending a letter. You send e-
mail from your computer at any time of the day to any address around the
world & your electronic letter will at its destination seconds after you send
it, when if the receiver lives on the other side of the world.

2. Opening an e-mail account : Opening an e-mail account means to
create an email address just like your home address. You can use it to send
and recieve e-mails to your friends, relatives or any other person you like.

3. Sending an e-mail : Sending an e-mail message is, in many ways,
similar to writing a letter without a stamp. In fact sending an e-mail is much
the same as sending a letter. The main difference is that the e-mail is
delivered almost instantly.

(G) 1.(b) 2.(d) 3.(e) 4 5.(o

Chapter-9

(A) 1. WHILE CONDITION

WEND

2. DO WHILE... LOOP is executed while the test expression in the loop is
true
3. By using EXIT FOR statement

B) 1. (a) 2.(a) 3.(c)

(C) Practical Work

(D) Practical Work

(E) 1. WEND 2. numeric, logical 3. WHILE 4. WEND

(F) Practical Work

(G) 1. No, the index variable in a FOR statement can not take a fractional or
negative value.
2. If we know the exact number of repetitions to be performed, we can use
the FOR-NEXT statement conveniently. The FOR statement is placed at the
beginning of the loop and the NEXT statement at the end.
3. When value reaches the NEXT statement, the value of the variable is



incremented and control is transferred back to the FOR statement. The loop
is executed again for the next value of the variable.

4. The loop will not execute in this condition.

5. Yes, under that condition FOR-NEXT loop will execute only once.

6. The control variable X is assigned the initial value of 1.

This value of the control variable is compared with the final value N. If it
exceeds the final value, control skips to the statement following the NEXT
statement.
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